ORACLE
EEEEEEEEEEEEEEEEEEEEEE

EnterpriseOne Supply Chain Planning
Demand Management 8.12 Forecast
Studio Implementation Guide

June 2006

ORACLE’



EnterpriseOne Supply Chain Planning Demand Management 8.12 Forecast Studio Implementation Guide
SKUE1 SCP812SFS-B_0606
Copyright © 2006, Oracle. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are
provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright,
patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the
Programs, except to the extent required to obtain interoperability with other independently created software or as
specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the
documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may
be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or
transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of
the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S. Government
customers are “commercial computer software” or “commercial technical data” pursuant to the applicable Federal
Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure,
modification, and adaptation of the Programs, including documentation and technical data, shall be subject to

the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the
additional rights set forth in FAR 52.227-19, Commercial Computer Software—Restricted Rights (June 1987). Oracle
Corporation, 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous
applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other
measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim
liability for any damages caused by such use of the Programs.

The Programs may provide links to Web sites and access to content, products, and services from third parties.

Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks
associated with the use of such content. If you choose to purchase any products or services from a third party, the
relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party
products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of
products or services and warranty obligations related to purchased products or services. Oracle is not responsible for
any loss or damage of any sort that you may incur from dealing with any third party.

Oracle, JD Edwards, PeopleSoft, and Siebel are registered trademarks of Oracle Corporation and/or its affiliates.
Other names may be trademarks of their respective owners.
Open Source Disclosure

Oracle takes no responsibility for its use or distribution of any open source or shareware software or documentation
and disclaims any and all liability or damages resulting from use of said software or documentation. The following
open source software may be used in Oracle’s PeopleSoft products and the following disclaimers are provided.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/). Copyright
© 1999-2000 The Apache Software Foundation. All rights reserved. THIS SOFTWARE IS PROVIDED “AS

IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. INNO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



Contents

Preface
EnterpriseOne Demand Management Forecast Studio Preface.............cccoveeevvnnnn nnnt. xiii
Related DOCUMENTAtION. . ... .. e et ettt e e Xiii
Obtaining Documentation Updates. ........ ..o e Xiii
Ordering Printed DOCUMENTAtioN. ... ... e ettt e xiii
Typographical Conventions and Visual CUES. ...ttt e Xiv
TypographiCal CoONVENTIONS. ... .. e ettt et aeaas Xiv
LY 45T | 1= Xiv
Comments and SUGGESTIONS. . ... ... e e XV
Chapter 1
Getting Started with EnterpriseOne Demand Forecasting...............cooiiiiiiiiiii i 1
EnterpriseOne Demand Forecasting OVervieW. ... ...ttt s aeaeeaas 1
EnterpriseOne Demand Forecasting BuSineSS ProCEeSSES. .......oiiiiiiiiiiiii e e i 2
EnterpriseOne Demand Forecasting Integrations. ... e eee 4
EnterpriseOne Demand Forecasting Implementation. ... e 5
Chapter 2
Understanding EnterpriseOne Demand Forecasting............ccoiiiiiiiiiiiiiiininnninine cennnnnans 9
Demand FOrECASTING. . . ...ttt ettt et e 9
CompPoNeNts Of @ FOrECaSt. ... ..o e e 9
Factors Influencing FOrecasting. ..........oouoiiiiiii i 10
FOreCast StUIO. ... ..ot e 10
Benefits of Using the Forecast StUdio. ........ ..o e 11
Forecast StUdIio INterfacCe. ... .. ..ooi i e e 1"
Forecasting MOGEIS. . . . ... e e 16
Forecasting and Time Series. ... ....ooiriiii e e 16
LT oY = I =Y oo £ 16
SEaSONAl VariatioNs. ... .. e 17
NON-Seasonal Variations. . .......... et et 17
Types of Models Used by Forecast Studio.............cooiiiiiiii i e 17
Exponential Smoothing MOEIS. ... e e e 19
Go0dNESS Of Fit StatiStiCS. ...\ttt e 21
Generated FOrECaSTS. ... .. ittt e 22

Copyright © 2006, Oracle. All rights reserved. iii



Contents

L€ = o] Y1 22
TIME SEMHES TabIE. ...t 23
Sl Oty StOCK. ...\t 24
Chapter 3
Using the Forecast Studio..........c.ccooiiiiiii i s 25
Starting and Logging into the Forecast Studio. ... i e e 25
Loading Demand MOGEIS. . ... ..ot ettt e et e 25
Chapter 4
Working With Filters..........cooiiii s aaaeeaas 27
Understanding Filers. .. ..o e 27
WOrKING With Filers. ..o ettt e ettt et e 27
Windows Used to Work With FIErS. ........ooi e e 28
Creating and Saving Fillers. ... ..o 28
Applying and Unapplying FIErs. ... e e e 29
EditiNg FIlOrs. . ..o e 30
ReNaMING FIEIS. ... oo e e 30
Dleting FIlErS. ..o e 30
Creating CUStOM FIllErs. . ... et et e e 30
USING Filter PermiSSiONS. ... ..o e e e 32
Chapter 5
Working With SCeNArios.........c.uuiiiiiiiii s aaarenas 33
UNderstanding SCENAIIOS. . ... . ...ttt ettt et et e e 33
RS 107 =T 0 = o T U 33
The SCENANO WIZAId. ...t e e e et e e e ettt ettt 34
R TeT=Y g F= o TN @ o o 1] = 14 =T T 35
What-lf SCENAMOS. ... et e e 36
IMPOort and EXPOrt SCENAIIOS. .. ...ttt et e et ettt 37
Show and Hide Invalid Demand Points. ... ... 37
SCENANO MANAGEIMENT. ...ttt 37
RS To7 =T =T o TN 1\ o (= 38
FOreCast GeNEIatiON. ... ..ottt e e e e 39
PUDIISN SCENAIOS. . ...t e e e e 40
=T Yo [ £ (= 40
Creating SCENAIIOS. . . ..ttt ettt e e e e 40

iv Copyright © 2006, Oracle. All rights reserved.



Contents

Windows Used to Create SCENAIIOS. . ... .oitttt ettt ettt et ettt e e e e eiin e eens 40
Creating Scenarios for One Demand Point. ... e 40
Creating Scenarios for a Set of Demand Points. ... 41
Creating Scenarios Using @ Filter. ... i e 42
Creating Scenarios for a Pre-Defined Demand Point Set.........ccooiiiiiiiiiii e 43
(07070 g o= T4 TaTe IR To7=T o P-4 T T 43
Windows Used to COMPAre SCENAIIOS. ... ...ttt ettt et ettt e et e e e e e e eie e eenas 43
Visually Comparing SCENAIIOS. . ... ..ottt e et e et e 43
Using the Scenario CompariSOn VIEW. .. ...t e 44
Creating What-If SCENAIIOS. . ...\ e e e e 44
PrErEQUISIEE. . ... i e e 44
Windows Used to Create What-If SCenarios. ...........c..ooiiiiii i 44
Creating What-If SCENAIIOS. . ... .ot e 44
Importing and EXPorting SCeNArios. ... ... e e 45
Windows Used to Import and EXport SCENArios. .......ooii et 45
IMPOMtING SCENAIIOS. . . ..ttt ettt e et 45
EXPOItiNG SCONAIIOS. ... . e e e 45
Showing and Hiding Invalid Demand POiNts. ...........oooiii e 45
1Y =T F= T g Yo TR Tt =Y o P= Ty T L= 46
Windows Used to Manage SCENAIIOS. ...ttt e e e e e e e eiie e 46
Adding Demand Points t0 SCENAMIOS. . ... 46
Deleting Demand Points from SCENAIOS. . ... .....uui et e 46
Editing Forecast Generation Parameters. .............oouiiiiii i 46
Editing Safety Stock Parameters. ... ... 47
RENAMING SCONAIIOS. . . . ..ottt ettt e e et e e e 47
DlEtiNg SCENAIIOS. . ..ottt e 47
Working With SCenario NOTES. ... i e e e 48
Windows Used to WOrk With NOtES. . ... et e 48
Adding Notes to Demand PoOiNtS. ..........ooiiiii e 48
Deleting Notes from Demand POINtS. ......... i e e 48
Showing and Hiding the Scenario Notes Column......... ... 48
GeNErating FOrECaSES. ... ..t 49
Windows Used to Generate FOreCasts. ... ... .ouiiiiiii e 49
Generating Forecasts for @ SCeNAario. . .......... i e 49
Generating Forecasts for a Selected Demand Point............ccooiiiiiiiiiiii e 49
Editing Generated FOreCasts. ... ... e 49
Windows Used to Edit Generated FOrecasts. ... e 50
Editing the ReSUILS Graph...........ooiii i e 50
Editing the Time Series Table. . ... ... i e e 50
Editing Sales History INformation............... e 51

Copyright © 2006, Oracle. All rights reserved. v



Contents

Editing Forecast History Information..............o 51
PUDIISNING SCENAIIOS. ... ..t e e e 51
Chapter 6
Working wWith Ad HOC QUEKIES.........uiiiiiiiiiiiii i r s aranes saneenns 53
Understanding Ad HOC QUETIES. . . . ...ttt et e et e eens 53

o [l T o3 8 TH =Y 1Y 53

Creation of Ad HOC QUETIES. ...t e ettt et ettt e s 53

Execution of Ad HOC QUETIES. . ...ttt e e et et e ae e e 54

Disaggregation of Ad HOC QUEry FOreCasts. ........ooiiiiiiiii e e e 54

Duplication of Ad HOC QUETIES. ... ... e e e e e 55

Export of Query Forecasts and Query Sales Histories. ... 55

O BT T T 1= o (1= 56
Creating Ad HOC QUETIES. . . . ..ottt ettt e ettt ettt e ettt et e e e eaea s 57

Windows Used to Work with Ad HOC QUETIES. ..o e e e e 57

Creating Ad HOC QUETIES. .. ..ottt et ettt e ettt et e ettt e e e e e s 57

RUNNING Ad HOC QUUETIES. ...ttt et e et e et e et ee e e 58

Duplicating Ad HOC QUETIES. .. ...ttt et ettt e ee e e 58

Disaggregating QUEry FOreCasts. ... ....uuiiiii i e e 59

EXPOrting QUENY FOrECaSES. . ...t e e et 59

Exporting Query Sales HistOries. ... ... 59

VIieWING QUETY PrOPEIES. . ..ottt ettt et et ettt e et 60

ReNAMING QUETIES. . . ..ot ettt e et et e et et e 60

Deleting Ad HOC QUETIES. . ... ..ttt et ettt e e ettt ee e 60
Chapter 7
Working with Forecast Versions...........ccovviiiiiiiiiiiiiieiiiiennsssssssasaaaannns sarnnnns 61
Understanding Forecasts and Forecast Versions. ............ouiiiiii i e 61

0T =T o= T P 61

FOrECaSE VBISIONS. . .. et e e e 62

oY= Tor= 1S 1\ o (= 62

(@70 01187 0 - 63

SalES HisStOry . ... 63

Product, Location, and Channel INformation. ...........c.ooiiiniii e e 64

Demand Point Initialization. ... e 64

Approval of Demand PoiNts. ... ..o 66

Cleared Demand PoOints. ... ... e e 67

Import and Export of Forecast Versions. ... 67

Vi Copyright © 2006, Oracle. All rights reserved.



Contents

Do o =T o= ) S 67
CoMPANiNg FOrBCaS S, ... i e e e 67
Forecast Disaggregation. ... ... .o e 67
Forecast BalanCing. ... ... e e 69
Working With FOrecast VersioNS. ..........coouiii i e e e 69
Windows Used to WOork With FOreCasts. .........ooiiii i 70
Adding Forecast Versions to a Demand Model. ... e 70
Renaming FOreCast VarSiONS. ... ... oo i e ettt 70
Deleting FOreCast VerSiONS. . ... ...ttt et ettt et 71
Selecting the Baseline Forecast VErsion. ...........ooooiiiiii e e 71
Comparing FOreCast VerSiONS. ... .. .o e 71
IMPOrting Sales HisStOrEs. . ... e e 71
Changing Product, Location, and Channel Information.................o e 71
Initializing Demand PoOiNtS. ..........ooii e 72
Approving Demand PoOiNtS. ... e 72
Clearing Demand POiNtS. . ... .. e 73
IMPOriNG FOreCast VerSIONS. . ..o e et et et e et et ettt e e ae e 73
EXPOrting FOreCast VErSiONS. .. ... e 73
FIXING FOrECaStS. . .. e e 74
Disaggregating FOreCasts. ......oooi i e 74
BalanCing FOrECastS. ... e 74
Working with Forecast Notes and Comments. ... .. ... e e 75
Windows Used to Work with Forecast NOtes. ......... ..o e 75
Adding Forecast Notes to Demand PoOints. ..........ooiiiiiii e 75
Deleting Forecast Notes from Demand PoiNts. ... e 75
Showing and Hiding the Forecast Notes Column. ... e 76
Adding Comments to Demand POINtS. ... ... 76
VIBWING COMMENTS. . .ttt ettt ettt e e ettt ettt e et 76
Copying Forecast Notes into COMMENTS. ......oouiiiiii et aeaeas 76
Working with Publishing Profiles. ... ... e e 76
Windows Used to Work With Publishing Profiles. ... i 77
Creating a Publishing Profile. ... ... e 77
Publishing Data Using Profiles. ....... ..o e 78
Editing Publishing Profiles. ........o e 78
Deleting Publishing Profiles. ....... ... e 78
Chapter 8
Working with Range Profiles........c.ccooiiiiii i e 79
Understanding Range Profiles. ........o o e 79

Copyright © 2006, Oracle. All rights reserved. vii



Contents

RaNGE FOrECaStiNg. ... .o 79
RANGE AlBIES. ..o 80
Forecasts Outside the FIeX FENCe. ... e 80
Export and Import of Range Profile Data.............c..oiiiiiii e 81
Export of Range Profile Alert REPOIS. ...t e 81
Range Profiles Management. . ... ... e 81
Working with Range Profiles. ... ... e e 82
Windows Used to Work with Range Profiles. .......... ... e e 83
Creating Range Profiles. . ... ..o 83
Assigning Demand Points to Range Profiles by Hierarchy...............oooo 84
Assigning Demand Points to Range Profiles by Property.............coooi 84
Generating Range AlBItS. . . ... .o et e e 85
Viewing Demand Points Outside of the Flex Fence.......... ... 85
Exporting Range Profile Alert REPOIMS. ... ....ooiii e 86
Viewing Range Alerts in the Graph VIEW. ... e e 86
Managing Range Profiles. ... ... e e 86
Renaming Range Profiles. ... ... 86
Duplicating Range Profiles. . ... ... e 86
Deleting Range Profiles. . . ... 87
Chapter 9
Working With OULHIErs. ... et e s s e e e rreeee srannnns 89
Understanding OULIIErS. . . ... ..o et e et e 89
L@ {1 T= 89
OUtlier ConfigUIatioN. . ... ..o e e 90
UL BT REVIBW. . ..ttt e ettt e ettt e et ettt et e e e 90
L@ U (1= gl =Y o= 1 91
WOrking With OULIEIS. . . ... o e e i e 91
Window Used to Work With OQULIEIS. ... et e a e 92
Configuring Outliers for DEteCHON. . . ... .o e e e 92
ReVIEWING OULIEIS. . ... e e e 92
=Y o 2= 11T To T U {1 1= 92
Chapter 10
Working With PrediCtors. .......c.oviiiiiiii i s e 95
Understanding PrediCtors. ... ... e e e 95
=T [T (o 95
PrediCtor CrEatioN. ... .. e e 96

viii Copyright © 2006, Oracle. All rights reserved.



Contents

Demand Point Predictor ASSIGNMENt. ....... .o e 96
Use Predictors With SCENEArIOS. ... e e 97
WOrKiNG With PrediCtors. . . ... e e ettt e 97
Windows Used to Work with Predictors. ... e 97
Creating PrediCtors. ... e 97
Assigning Demand Points to PrediCtors. ........ ... 98
IMPOrtiNg PrediCtors. .. ... e 99
EXPOrtiNg PrediClors. .. ..o 99
Importing Demand Point Predictor ASSIgNmEeNts. ... ... i 100
Exporting Demand Point Predictor Assignments. ........ ... 100
MaNaging PrediCtors. .. ..o e 100
ReNamMing PrediCtors. .. ... .o e 100
Editing PrediCtors. . . ... ..o e e 101
Deleting PrediCtors. . ... ..o e 101
Removing Demand Points from PrediCtors. ......... ..o 101
Using Predictors With SCENArios. . . ... e e 101
Chapter 11
Working With EVENtS. ........ccooiiiiiiiiiii e r it e easa s s e e s nnnnnnnns snnnnns 103
Understanding Events and INterventions. ... .. ... 103
Events and INterventions. ... ... ....oiii e 103
Demand Point EVENt ASSIGNMENt. . ... ..o e 104
Creation Of INterVeNtiONS. . ... o e 105
Import and Export of Demand Point Intervention Assignments.................oii i 105
Use of Interventions with SCENArios. ..ot e 105
WOrKING With EVENTS. . ... e et ettt e e 106
Windows Used to Work with EVents. ........ ..o 106
Creating EVeNES. . ..o 106
Assigning Demand Points to Events by Hierarchy...... ... 106
Assigning Demand Points to Events by Property......... ... 107
MaNAgINg EVENES. ... e 108
RENaAMING EVENtS. ... e 108
AddiNg NEeW EVENt Dates. .. ...ttt e e 109
Changing EVENt Dates. ... .....oiiiii e e e 109
Changing the Dates of a Single EVent. ... ... ... e 109
Deleting EVENt Dates. . ... .o e e 109
Deleting EVENtS. ... 110
Removing Demand Points from EVents. ... 110
Importing and EXporting EVENTS. . . ... e 110

Copyright © 2006, Oracle. All rights reserved. ix



Contents

IMPOItING EVENTS. .. e 110
EXPOrING EVENES. . ..o 111
Importing Demand Point Event ASSIGNMENtS. . ... 111
Exporting Demand Point Event ASSINMENtS. ....... ... 111
Working with EVENtS @and SCENAIIOS. ... .....oiitt i e e 111
Using Events With SCENAIIOS. . . ... e e e 112
Chapter 12
Working with Interventions.........c.ccviiiiiiii i 13
Working With INterventioNS. ... . ... e 113
Windows Used to Work with Interventions. ... ... s 113
Creating INterVENTIONS. . . ... ettt e 113
Assigning Demand Points to Interventions by Hierarchy...................ooii i 114
Assigning Demand Points to Interventions by Property........... ..o 114
Managing INterVENTIONS. . . ... .. e et e 115
Editing INterventions. ... .. oo e 116
Renaming INterventionS. ... ... oo e 116
Deleting INterventioNS. . ... ... e 116
Removing Demand Points from Interventions. ......... ... e 117
IMPOrtiNG INtErVENtIONS. . .. e e et e e e e 117
EXPOrting INterventioNnsS. . ... ... e 117
Importing Demand Point Intervention Assignments. ..o e 117
Exporting Demand Point Intervention Assignments. ... 117
Using Interventions With SCENAMOS. ... ... ..t e e 118
Chapter 13
Working with Forecast Accuracy Reports. ........ccviiiiiiiiiiiiiiiii i ieascese e cannees 19
Understanding Forecast ACCUraCy REPOITS. . ... ..t s 119
Forecast ACCUraCy REPOITS. ... ... e ee s 119
Forecast Accuracy Report Definition. ......... ..o e 120
Working with Forecast ACCUracy REPOIS. ........ooi e e e 121
Window Used to Work with Forecast Accuracy REpOrtS. ..........ooiiiiiiiii e 121
Defining Forecast Accuracy Reports by Demand Point Aggregation....................c.cciiiia. 121
Defining Forecast Accuracy Reports by Demand Point Properties. ... 122
Running Forecast ACCUracy REPOIS. . ... e eee e e 123
Editing Forecast Accuracy Reports Based on Demand Point Aggregations............................... 123
Editing Forecast Accuracy Reports Based on Demand Point Properties.............ccccovvviiiiiiinn..n. 124
Renaming Forecast ACCUracy REPOITS. ... ...ttt e ee e e 125

X Copyright © 2006, Oracle. All rights reserved.



Contents

Deleting Forecast ACCUracy REPOIES. ... ... .. e e e eeeas 125
Chapter 14
Working With Forecast History Data...........c.ccccoiiiiiiiiiii e e mnanas 127
Understanding Forecast History Data. ..........oooiiiii e e 127
Understanding Importing Forecast History Data..............oooiiiiii e 127
Understanding Exporting Forecast History Data. ... 127
Windows Used When Working with Forecast History Data. ... 128
Importing Forecast History Data. ..o e 128
Exporting Forecast History Data.......... ..o 128
Clearing Forecast History Data. ..........ooiiii e e e s 128
Viewing Forecast History Data in the Time Series Table.......... ... e 129
Viewing Forecast History in Graph VIeW. ... ..o i e 129
Chapter 15
Working With Effective Dates...........oooiiiiiiiiiii i e raaees 131
Understanding Effective Dates. ........ooiuiii e 131
Viewing Demand Points with Effective Dates in the Time Series Table.....................ooociii it 131
Windows Used to View Demand Points with Effective Dates in the Time Series Table.................. 132
Viewing Demand Points with Effective Dates in the Time Series Table. ... cnnnn. 132
Viewing Demand Points with Effective Dates in Graph View. ...t e 132
Editing Demand Points With Effective Dates in the Time Series Table.................cocoiiiiiii e, 133
Editing Demand Points With Effective Dates in the Graph View. ... 133
3 o 1= 135

Copyright © 2006, Oracle. All rights reserved. Xi



Contents

Xii Copyright © 2006, Oracle. All rights reserved.



EnterpriseOne Demand Management
Forecast Studio Preface

This preface discusses:

* Related documentation.

* Typographical Conventions and Visual Cues.

Note. This Implementation Guide documents only page elements that require additional explanation. If a page element
is not documented with the process or task in which it is used, then it either requires no additional explanation or is
documented with the common elements for the section, chapter, or Implementation Guide.

Related Documentation

This section discusses how to:

* Obtain documentation updates

* Order printed documentation

Obtaining Documentation Updates

The EnterpriseOne Demand Management Forecast Studio Implementation Guide provides you with
information about how to implement and use the EnterpriseOne Demand Management Forecast Studio system.
Additional essential information describing deployment and supplemental third-party software options resides
in the Supply Chain Planning Hardware and Software Requirements Guide. You should be familiar with the
contents of this guide.

Ordering Printed Documentation

You can order printed, bound volumes of the complete Oracle documentation that is delivered on the
Implementation Guides CD-ROM. Oracle makes printed documentation available for each major release
shortly after the software is shipped. Customers and partners can order the documentation in the following
ways:

* Electronic mail: appsdoc_us@oracle.com
* FAX: 650-506—7200 Attn: Oracle EnterpriseOne Demand Management Manager
* Postal Service:

Oracle EnterpriseOne Demand Management Manager

Oracle Corporation

500 Oracle Parkway

Redwood Shores, CA 94065

USA
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If you would like a reply, please give your name, address, telephone number, and electronic mail address
(optional).

Typographical Conventions and Visual Cues

This section discusses:

» Typographical conventions

¢ Visual cues

Typographical Conventions

The following table contains the typographical conventions that are used in Implementation Guides:

Typographical Convention or Visual Cue Description

nn

(quotation marks) Indicate chapter titles in cross-references and words that
are used differently from their intended meanings.

{ } (curly braces) Indicate a choice between two options in code syntax.
Options are separated by a pipe () ).

[ 1 (square brackets) Indicate optional items in code syntax.

Cross-references Implementation Guides provide cross-references either
following the heading "See Also" or on a separate line
preceded by the word See. Cross-references lead to
other documentation that is pertinent to the immediately
preceding documentation.

Visual Cues
Implementation Guides contain the following visual cues.
Notes

Notes indicate information that you should pay particular attention to as you work with the EnterpriseOne
system.

Note. Example of a note.

A note that is preceded by Important! is crucial and includes information that concerns what you must do for
the system to function properly.

Note. Example of an important note.

Warnings

Warnings indicate crucial configuration considerations. Pay close attention to warning messages.

Xiv Copyright © 2006, Oracle. All rights reserved.
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Note. Example of a warning.

Comments and Suggestions

Your comments are important to us. We encourage you to tell us what you like, or what you would like to
see changed about Implementation Guides and other Oracle reference and training materials. Please send
your suggestions to:

Oracle EnterpriseOne Demand Management Documentation Manager
Oracle Corporation

500 Oracle Parkway

Redwood Shores, CA 94065

USA

Or email comments to: appsdoc_us@oracle.com.

While we cannot guarantee to answer every email message, we will pay careful attention to your comments
and suggestions.
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CHAPTER 1

Getting Started with EnterpriseOne
Demand Forecasting

This chapter provides an overview of EnterpriseOne Demand Forecasting and discusses:
* EnterpriseOne Demand Forecasting business processes.
* EnterpriseOne Demand Forecasting integrations.

 EnterpriseOne Demand Forecasting implementation.

EnterpriseOne Demand Forecasting Overview

EnterpriseOne Demand Forecasting enables you to plan for and meet future demand by creating on accurate
business forecasts. Accurate forecasts ensure that you have sufficient stocks of products available when
you need them.

A forecast is based on a demand model, which contains:
* Historical information on sales - for example, sales at specific locations and during specific periods.
* Historical demand for parts, components, or materials from suppliers.

* Information about promotions, sales campaigns, or other initiatives that can affect demand.

Without accurate forecasts, you leave yourself vulnerable to a variety of problems, including higher inventory,
transportation, and production costs; increased levels of safety stock; and unexpected changes in the inventory
balance across your enterprise. With EnterpriseOne Demand Forecasting, you can create meaningful
schedules, production plans, and financial plans to meet that demand.

Forecast Studio

The Forecast Studio is the EnterpriseOne Demand Forecasting workspace. You can use it to:
 Create, customize, and maintain forecast data

» Generate forecasts that are based on various criteria.

» Refine your forecasts by taking into account the effects of predictors, events, and interventions on those
forecasts.

* View the information in your forecasts either graphically or in tabular format.

You can apply different statistical techniques to different forecast models; choose the forecasting algorithm
that best suits your needs; or use the expert selection algorithm, which picks the algorithm that best suits your
needs. As well, you can apply different algorithms to different demand points to further refine your forecasts.
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EnterpriseOne Demand Forecasting Business Processes

The following process flow illustrates the Demand Forecasting process:
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EnterpriseOne Demand Forecasting Integrations

EnterpriseOne Demand Forecasting can integrate with other EnterpriseOne Supply Chain Management and
EnterpriseOne Supply Chain Planning systems through the EnterpriseOne Supply Chain Business Modeler
application. The following graphic shows how EnterpriseOne Demand Forecasting integrates with other
applications through EnterpriseOne Supply Chain Business Modeler:

Using EnterpriseOne Supply Chain Business Modeler, you can transfer supply chain data from EnterpriseOne
Supply Chain Management systems into EnterpriseOne Demand Forecasting. You can then use Demand
Forecasting to create enterprise demand forecasts and inventory safety targets based on the data.

After creating forecasts in EnterpriseOne Demand Forecasting, you can use EnterpriseOne Supply Chain
Business Modeler to transfer the plans to another EnterpriseOne Supply Chain Planning system for further
refinement or to a EnterpriseOne Supply Chain Management system for further refinement or implementation.

EnterpriseOne Supply Chain Management Systems

EnterpriseOne Supply Chain Management systems, such as Enterprise Supply Chain Management,
EnterpriseOne Supply Chain Management, and World Manufacturing Management, provide EnterpriseOne
Supply Chain Business Modeler with the supply chain data that EnterpriseOne Demand Forecasting uses
to generate accurate forecasts. The data includes information about items, branches, inventory policies,
and manufacturing processes.

After EnterpriseOne Demand Forecasting creates optimal forecasts using the data, you can transfer the
forecasts through EnterpriseOne Supply Chain Business Modeler to a EnterpriseOne Supply Chain
Management system for further refinement or implementation.

EnterpriseOne Sales and Operations Planning

Using EnterpriseOne Supply Chain Business Modeler, you can transfer supply chain data from EnterpriseOne
Demand Forecasting to EnterpriseOne Sales and Operations Planning.

EnterpriseOne Strategic Network Optimization

Using EnterpriseOne Supply Chain Business Modeler, you can transfer demand forecasts from EnterpriseOne
Demand Forecasting into EnterpriseOne Strategic Network Optimization. You can then use Strategic Network
Optimization to create inventory build targets and sourcing recommendations based on the data.

After creating supply chain plans in EnterpriseOne Strategic Network Optimization, you can use EnterpriseOne
Supply Chain Business Modeler to transfer the plans to another EnterpriseOne Supply Chain Planning system
for further refinement or to a EnterpriseOne Supply Chain Management system for further refinement or
implementation.

EnterpriseOne Production and Distribution Planning

Using EnterpriseOne Supply Chain Business Modeler, you can transfer supply chain plans from EnterpriseOne
Demand Forecasting into EnterpriseOne Production and Distribution Planning. You can then use
EnterpriseOne Production and Distribution Planning to create net deployment requirements and net production
requirements based on the data.

After creating supply chain plans in EnterpriseOne Production and Distribution Planning, you can use
EnterpriseOne Supply Chain Business Modeler to transfer the plans to another EnterpriseOne Supply Chain
Planning system for further refinement or to a EnterpriseOne Supply Chain Management system for further
refinement or implementation.
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EnterpriseOne Order Promising

Using EnterpriseOne Supply Chain Business Modeler, you can transfer supply chain data from a EnterpriseOne
Supply Chain Management system to create a model in EnterpriseOne Order Promising.

EnterpriseOne Production Scheduling - Discrete and EnterpriseOne Production
Scheduling - Process

Using EnterpriseOne Supply Chain Business Modeler, you can transfer supply chain plans from EnterpriseOne
Demand Forecasting into EnterpriseOne Production Scheduling - Discrete and EnterpriseOne Production
Scheduling - Process. The EnterpriseOne Supply Chain Planning production scheduling applications can then
produce optimal production schedules for meeting the production targets.

Supplemental information about third-party application integrations is located on the EnterpriseOne Customer
Connection website.

EnterpriseOne Demand Forecasting Implementation

The EnterpriseOne Demand Forecasting implementation process can be divided into the following steps:

* Installing EnterpriseOne Demand Forecasting.

* Creating forecast versions.

* Creating and managing scenarios.

* Identifying and repairing outliers.

* Creating and assigning predictors, events, and interventions.
* Generating forecasts.

* Disaggregating and balancing forecasts.

Installing EnterpriseOne Demand Forecasting

Step Reference

Install EnterpriseOne Demand Forecasting. Demand Management Installation Guide for
Windows.

Demand Management Installation Guide for UNIX.
Demand Management Installation Guide for LINUX.

Creating Forecast Versions

Step Reference

Create a forecast version. “Working with Forecast Versions”, “Adding Forecast
Versions to a Demand Model”, Forecast Studio
Implementation Guide.
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Creating and Managing Scenarios

Chapter 1

Step

Reference

Create a scenario.

“Working with Scenarios”, Forecast Studio
Implementation Guide.

Managing a scenario.

“Working with Scenarios”, “Managing Scenarios”,
Forecast Studio Implementation Guide.

Publish a scenario.

“Working with Scenarios”, “Publishing Scenarios”,
Forecast Studio Implementation Guide.

Identifying and Repairing Outliers

Step Reference
Detect outliers. “Working with Outliers”, “Configuring Outliers for
Detection”, Forecast Studio Implementation Guide.
Repair outliers. “Working with Outliers”, “Repairing Outliers for

Detection”, Forecast Studio Implementation Guide.

Creating and Assigning Predictors, Events, and Interventions

Step

Reference

Create predictors.

“Working with Predictors”, “Creating Predictors”,
Forecast Studio Implementation Guide.

Assign predictors to demand points.

“Working with Predictors”, “Assigning Predictors to
Demand Points”, Forecast Studio Implementation
Guide.

Create events.

“Working with Events”, “Creating Events”, Forecast
Studio Implementation Guide.

Assign events to demand points.

“Working with Events”, “Assigning Events to Demand
Points by Hierarchy”, Forecast Studio Implementation
Guide.

“Working with Events”, “Assigning Events to Demand
Points by Property”, Forecast Studio Implementation
Guide.

Create interventions.

“Working with Interventions”, “Creating Interventions”,
Forecast Studio Implementation Guide.

Assign interventions to demand points.

“Working with Interventions”, “Assigning Interventions
to Demand Points by Hierarchy”, Forecast Studio
Implementation Guide.

“Working with Interventions”, “Assigning Interventions
to Demand Points by Property”, Forecast Studio
Implementation Guide.
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Generating Forecasts

Step Reference
Install EnterpriseOne Demand Forecasting. “Working with Scenarios”, “Generating a Forecast”,
Forecast Studio Implementation Guide.

Disaggregating and Balancing Forecasts

Step Reference

Disaggregate a forecast. “Disaggregating Forecasts”, Forecast Studio
Implementation Guide.

Balance a forecast. “Balancing Forecasts”, “Working with Scenarios”,
Forecast Studio Implementation Guide.
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CHAPTER 2

Understanding EnterpriseOne Demand
Forecasting

This chapter discusses:

* Demand forecasting.

* Components of a forecast.

* Forecast Studio.

* Forecasting models.

» Exponential smoothing models.
* Goodness of fit statistics.

» Generated forecasts.

Demand Forecasting

The ability of an enterprise to plan for and meet future demand depends on accurate business forecasts.
Accurate forecasts ensure that you have sufficient stocks of products available when you need them

A forecast for the future demand for products is based on a demand model, which contains:
* Historical information on sales - for example, sales at specific locations and during specific periods.
* Historical demand for parts, components, or materials from suppliers.

* Information about promotions, sales campaigns, or other initiatives that can affect demand.

Without accurate forecasts, you leave yourself vulnerable to a variety of problems, including higher inventory,
transportation, and production costs; increased levels of safety stock; and unexpected changes in the inventory
balance across your enterprise. Your forecast enables you to create meaningful schedules, production plans,
and financial plans to meet that demand. However, because forecasts can constantly change, you also need a
way to easily modify and manipulate your forecasts.

Components of a Forecast

A forecast consists of these components:

* Demand model

Copyright © 2006, Oracle. All rights reserved. 9



Understanding EnterpriseOne Demand Forecasting Chapter 2

Contains both the forecast data and the business model data. The forecast data consists of the values for the
demand while the business model contains such information as product, location, and channel data; horizon;
unit of measure data; and aggregation hierarchy data.

Sales history

A file in Extensible Markup Language (XML) format that contains detailed information on the sales of
products at locations in your enterprise. It also acts as a time series of sales data for a number of buckets
for a particular product sold at a particular location. You import the sales history into the demand model
when working with forecasts in the Forecast Studio.

Forecast version

A container that mimics the structure of the demand model currently loaded into the Forecast Studio. You
can populate a forecast version with the data from one or more scenarios, and use the information as your
forecast. You can add one or more forecast versions to a demand model. You can also import or export a

forecast version to or from an XML file.

Scenario

Contains the information that is used to populate a forecast - product, location, and channel data; sales
history; the unit of measure being used; and so on. Using scenarios, you can isolate a single demand point
or multiple demand points, and use this information as the basis for a forecast. You can also import or
export a scenario to or from an XML file.

Factors Influencing Forecasting

While historical demand is the main influence on the accuracy of a forecast, other factors can also influence
your forecasts. You must take into account a number of other unpredictable factors that can influence
forecasts, including:

New products with no historical data.
Fluctuations in the economy.

New or amended laws and regulations.
Natural disasters.

Innovations from your competitors.

The influence of special promotions on sales.

Forecast Studio

The Forecast Studio is a workspace that you can use to:

10

L]

L]

Create, customize, and maintain forecast data
Generate forecasts that are based on various criteria.

Refine your forecasts by taking into account the effects of predictors, events, and interventions on those
forecasts.

View the information in your forecasts either graphically or in tabular format.
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You can apply different statistical techniques to different forecast models; choose the forecasting algorithm
that best suits your needs; or use the expert selection algorithm, which picks the algorithm that best suits your
needs. As well, you can apply different algorithms to different demand points to further refine your forecasts.

Benefits of Using the Forecast Studio

By using the Forecast Studio, your enterprise can plan for and meet future demand using accurate business
forecasts. The major benefits of using the Forecast Studio include:

» The ability to generate accurate forecasts.

* Decreased chances of underestimating or overestimating demand.
* The ability to better adapt to changes in demand.

* The ability to predict future demand based on historical sales data.

* The ability to include business intelligence in the forecasting process.

Forecast Studio Interface

This screen shows the components of the Consensus Conference Room user interface:
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Forecast Studio User Interface
The Forecast Studio interface consists of:

Menu bar.

Tool bar.

Navigation bar.
Shortcuts bar.
Scenarios view.
Forecast Versions view.
Queries view.

Graph view.

Predictors Graph view.
Model Statistics view.
Time Series table.

Scenario view.

12
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* Scenario Comparison view.

Menu Bar

The menu bar provides access to all of the Forecast Studio functions. You can access functions and commands
by choosing items from the menu.

Forecast Studio Toolbar

The icons on the toolbar give you quick access to common Forecast Studio commands

Shortcuts bar

The Shortcuts bar enables you to quickly move between the Forecast Studio workspaces. Click an icon on the
Shortcuts bar to display a workspace.

Scenarios Workspace

The Scenarios workspace displays the scenarios that are defined for the demand model with which you are
working. The names of scenarios are displayed alphabetically in list format.

Note. You can access a number of common menu and tool bar commands by right-clicking list of scenario
names in the Scenarios workspace.

Forecast Versions Workspace

The Forecasts workspace displays the forecast versions that are defined for the demand model with which you
are working. The names of the forecast versions are displayed alphabetically in list format.

Note. You can access a number of common menu and tool bar commands by right-clicking list of forecast
version names in the Forecast Versions workspace.

Model Statistics View

The Model Statistics view is a floating panel that displays the statistical model that is being used to generate
the forecast, the fit statistics for the forecast, and various key performance indicators for the scenario and
its demand points

This image shows the Model Statistics view:

Copyright © 2006, Oracle. All rights reserved. 13



Understanding EnterpriseOne Demand Forecasting

14

Chapter 2

E'-'Inrlrl! Gtabiskrs Ei
—Shalistical Model
Model Simple Sessona
Seazonaliby 12
Transhommshion: Plore
— M odal Paramedars:
Level 00=7a16
SEasore 1 575%=005
Trend MR
Trend Damping WA
—Eialy_ﬁi_m:k. .................................. i
Lead lme 1
Service level 95 %
Sid D 2104, 44
Sifesy Shock J4E1.5
—Fit Sealistics
MAE: 166754
MAFE; NIEHR
MAZAE: 47763
MA=APE: 935184
LOGLE: 325,763
MSE: 4 4B e+ 005
RiMSE: 211e8
RS0 0260443
MFMEIC: 15.5181
A Ea5.58S
BIC: B36 B2

Model Statistics view

The upper portion of the Model Statistics view lists:

* The statistical model that is used to generate the forecast, as well as the number of seasonal periods used.

* The various parameters used by the statistical model when generating the forecast. These parameters are
useful when comparing two scenarios.

The lower portion of the view lists:

 The safety stock parameters that are set for the forecast.

» The goodness of fit statistics for the forecast.

Note. When you use Croston’s Model as the forecasting model, the Model Statistics view displays the
results that are generated by Croston’s model in place of the fit statistics.

Queries View

The Queries view displays saved queries, and allows you to update query definitions.
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Graph View

The Graph view displays line graphs that illustrate the historical data and forecast information for the period
covered by the demand model.

Independent Series Graph View

The Independent Series Graph view displays line graphs that illustrate the predictor, event, or intervention
information associated with a demand point. You choose the predictor, event, or intervention to view using
the selector.

Note. The Independent Series Graph is only displayed in the Scenario workspace.

Time Series Table

The Time Series table displays the historical information for the demand model, as well as the corresponding
information for the generated forecast. You can also edit the values in the Time Series table to adjust your
forecast.

Scenario View

The Scenario view is a dockable panel that displays the demand points in a scenario, the statistical model being
used by the demand points in the scenario, and the fit statistics for each product or location.

Scenario Comparison View

The Scenario Comparison view enables you to contrast the model statistics of each scenario that you defined
for the demand model. This view displays data in a table and lists the statistical model that is used to generate
the forecast, as well as the values returned by the exponential smoothing models. Selecting multiple scenarios
also allows you to overlay the history and forecast graphs in the Graph view.

Predictors Workspace

You work with predictors (time series that represent external, independent variables) in the Predictors
workspace.

Note. You can access a number of common menu and tool bar commands by right-clicking list of predictor
names in the Predictors workspace.

Events/Interventions Workspace

You work with events and interventions (sudden occurrences or disturbances that negatively effect the accuracy
of the forecast) in the Events/Interventions workspace.

Note. You can access a number of common menu and tool bar commands by right-clicking list of event or
intervention names in the Events/Interventions workspace.

Queries Workspace

You work with ad hoc queries (searches for information in the database that are based on user-specified
criteria) in the Events/Interventions workspace. The Queries workspace also displays:

* The unit of measure used by the query that is currently selected in the Queries pane.

» The date and time when the query was last run.
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Range Profiles Workspace

You work with range forecasts (comparisons of multiple statements of demand across a forecasting horizon) in
the Range Profiles workspace. The Ranges Profiles workspace displays a list of the profiles that make up a
range forecast, as well as a table that defines the upper and lower levels of variation in a forecast.

See Also

Creating What-If Scenarios

Working with Range Profiles

Working with Predictors

Understanding Events and Interventions

Working with Ad Hoc Queries

Forecasting Models

16

Generating an accurate forecast depends not only on having the correct data, but also on using the correct
forecasting model for your needs. Without the proper model, you cannot generate an accurate forecast.

A forecasting model provides a statistical framework for predicting demand based on historical patterns. The
forecasting model that you choose determines any sales trends based on the sales history from recent years,
and then extrapolates these trends into the next year or further, depending on your forecasting horizon.

Forecasting and Time Series

Central to any forecast is a time series, which is a set of historical data that was collected over a specific
period - for example, monthly sales information. By analyzing the time series, you can deduce patterns in
demand, as well as see any variations in demand that are caused by seasonality or one-time incidents - for
example, a natural disaster.

Each time series appears in the Time Series table. The Time Series table displays the historical information for
the demand points in the forecast version, as well as the corresponding information for the generated forecast.

In the context of a forecasting model, a time series can also contain information about:

¢ General trends.
¢ Seasonal variations.

¢ Non-seasonal variations.

General Trends

General trends represent an increase or decrease in the demand for an item over the period that is represented
by the time series. Two types of general trends are:

¢ Global

Overall trends that affect the time series as a whole - for example, a steady drop in the sales of an aging
product.

e Local
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Trends that only affect certain portions of the time series - for example, a sudden increase in sales due
to an aggressive marketing campaign.

Trends can also be:

e Linear

A simple increase or decrease in the level of the time series that is caused, for example, by upswings or
downswings in demand.

* Nonlinear

A trend that can randomly increase the level of the time series. Any changes in the level are based on
the previous values in the time series.

Seasonal Variations

Seasonal variations, also called seasonality, are changes in the demand for an item that occur regularly and
predictably during the period that is represented by the time series. The demand for some products, for
example, might be low in the first part of the year but significantly increase from September to December.

Non-Seasonal Variations

Non-seasonal variations are unpredictable events that occur during the period that is represented by the time
series and affect the demand for an item. These variations can be, for example, one-time aberrations, such as a
natural disaster, or such recurring events as stock market downturns.

Types of Models Used by Forecast Studio

By default, the Forecast Studio uses an Expert Modeler to determine the best model to apply to a particular
forecast, as well as a number of goodness of fit statistics to determine how the results of the forecast fit the data
from the sales history. The Forecast Studio also uses two specific types of forecasting models:

* ARIMA models.
* Exponential smoothing models.
Expert Modeler

The Expert Modeler (labeled Expert Model Selection in the Forecast Studio) looks at the demand pattern for
each demand point in your demand model and selects the forecasting model best suited for forecasting the
demand at each demand point.

ARIMA Models

ARIMA is the acronym for Autoregressive Integrated Moving Average. ARIMA is a method of selecting one
of several forecasting models that is best suited to generating a forecast based on your data.

ARIMA models are quite complex and are well-suited for generating precise forecasting based on your data.
An ARIMA model also enables you to include predictors that can help clarify the forecast.

An ARIMA model is generally expressed as:
ARIMA(p,d,q)
where:

* p is the order in which the model performs autoregression.
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* d is the order in which the model performs integration.
* ¢ is the order in which the model performs moving average.
ARIMA models carry out three basic processes:

* Autoregression
* Integration (also called differencing)
* Moving Average

Using these processes, an ARIMA model can explain various correlations in the data and deal with trends.

Autoregression

The autoregression process treats each value in the time series as linear functions of the values that came
before it. For example, suppose that a times series has three values:

* The third value is a function of the preceding two values.

¢ The second value is a function of the first value.

Autoregression models any changes or variations between intervals in a time series. Each value in the
autoregression process is a weighted average of the most recent preceding values in the time series.

The autoregression process is mathematically expressed as:
Value~ Coefficient X Value.;+ Noise,
where:

* Value, is the value of the series at time period .

» Coefficient is a value that specifies how a value depends on the preceding value. The coefficient can be
a positive or negative value.

* Valuey, is the value of the series at time period #-1.

* Noise, is the amount of error associated with the series at time period .

Autoregression is useful when you are generating forecasts over a long term.

Integration

Integration (also called differencing) is a process that attempts to make a time series stationary. The time series
is stationary when it has no trend or seasonality. However, most time series are not stationary because they
contain some form of trend or seasonality. The ARIMA model uses the mathematical process of differencing
to remove the seasonality and trend from the time series.

Moving Average

Moving average is a method that an ARIMA model uses to generate forecasts that are based on deviations
of previous values from the average in the time series. Moving average is useful when a time series has
short-term variations.

This process models any changes or variations between intervals in a time series. Each value in the moving
process is a weighted average of the most recent variations in the preceding values in the time series.

Mathematically, the moving average process is expressed as:

Value~ Coefficient x Noise.+ Noise;
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where:

* Value, is the value of the series at time period ¢.

* Coefficient is a value that specifies how a value depends on the preceding value. The coefficient can be
a positive or negative value.

* Noisey is the amount of error associated with the series at time period .

Exponential Smoothing Models

Exponential smoothing is a mathematical technique that is used to predict future sales trends or demand
based on sales history or past demand. The exponential smoothing models return a smoothed time series,
which decreases the weightings of older results. This process ensures that the more recent the result, the
greater the weight it has in the forecast. The exponential smoothing models require historical data from
at least two previous periods.

The exponential smoothing models also consider any variances in demand. This process recognizes that
these variances can depend on short-term or one-time trends, as well as seasonal demand. Unlike ARIMA
models, exponential smoothing models do not understand the behavior of a forecast; they only describe the
behavior of the time series in a forecast.

Exponential smoothing models are best suited for short-term forecasting. If you intend to forecast over
longer periods, use the ARIMA model.

The Forecast Studio uses these smoothing models:

» Winter’s Additive

» Winter’s Multiplicative
» Brown’s Exponential

* Holt’s Linear

» Simple

» Simple Seasonal

* Damped

Smoothing Parameters
The exponential smoothing models that are used by Forecast Studio rely on combinations of these parameters:

» Level

Determines the speed at which the effect of the current value of a series on a future value of the series
decreases. The larger the value, the more the model is weighted to recent values.

» Season

Determines the speed at which the effect of the current value of a series on seasonality estimation of the
series decreases. The larger the value, the faster the effects of the series on seasonality decrease.

e Trend

Determines the speed at which the effect of the current value of a series on the overall trend of the series
decreases. The larger the trend, the faster the effect of the series on the future trend decreases.
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* Damping trend

Determines the speed at which the magnitude of the trend of the series decreases. The larger the trend, the
more gradually the trend of the series decreases.

Using these parameters, the forecasting model determines the weight of the results in the forecast. A larger
value means that the results have a greater weight in the forecast.

Winter’s Additive

The Winter’s Additive smoothing model is best used with a time series that has a linear trend and a constant
seasonal variation. This model uses the level, trend, and season smoothing parameters.

Winter’s Multiplicative

The Winter’s Multiplicative smoothing model is best used with a time series that has a linear trend and
a seasonal variation that changes, based on the magnitude of the time series. This model uses the level,
trend, and season smoothing parameters.

Brown’s Exponential

The Brown’s Exponential smoothing model is best used with a time series that has a linear trend and

no seasonal variation. This model uses the level and trend smoothing parameters. However, Brown’s
Exponential gives both parameters equal value. Brown’s Exponential smoothing model is similar to Holt’s
Linear smoothing model, but deals with more specific scenarios and can generate forecasts faster than Holt’s
Linear smoothing model.

Holt’s Linear

The Holt’s Linear smoothing model is best used with a time series that has a linear trend and no seasonal
variation. This model uses the level and trend smoothing parameters. Unlike other models, each parameter
used by Holt’s Linear is not constrained by the value of another parameter. Holt’s Linear smoothing model is
similar to Brown’s Exponential smoothing model, but it deals with more generalized scenarios.

Simple

The Simple smoothing model is best used with a time series that has no trend or seasonal variation. This
model uses the level smoothing parameter.

Simple Seasonal

The Simple Seasonal smoothing model is best used with a time series that has no trend and a constant seasonal
variation. This model uses the level and season smoothing parameters.

Damped

The Damped smoothing model is best used with a time series that has a linear trend which is dying out and no
seasonal variation. This model uses the level, trend, and damping trend smoothing parameters.

Croston’s Intermittent Demand

When demand for a product is sporadic, using exponential smoothing to model demand can return poor results.
When demand is low, the model over-forecasts demand. When demand is higher, the model under-forecasts
demand
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Croston’s Intermittent Demand model alleviates the problems that are caused by forecasting products with
sporadic demand by adding an extra parameter to the model. This parameter corresponds to the likelihood
that demand for the product will exist. The Model Statistics view displays the results that are generated by
Croston’s model in place of the fit statistics. In the Scenario Properties dialog box, you must select a separate
confidence level (expressed as a percentage), which is required by the model. Croston’s Intermittent Demand
smoothing model plots the replenishment amount and the average interval in the Graph view.

Goodness of Fit Statistics

The goodness of fit statistics determine how the results of a forecast fit the data from the sales history. Each
goodness of fit statistic measures a different aspect of how the forecast fits the sales history. Generally, a
smaller value means a better fit.

The goodness of fit statistics are specific to individual scenarios and appear in the Model Statistics view. They
only appear when you generate a forecast for a demand point in the scenario.

This table explains the goodness of fit statistics used by the Forecast Studio:

Fit Statistic Description

MAE Mean Absolute Error. A measure of the how much a
forecast differs from the level that is predicted in the model.
You can easily interpret MAE because it uses the same
units of measure as the current time series.

MAPE Mean Absolute Percent Error. Like MAE, MAPE measures
how much a forecast differs from the level that the model
predicts. However, you can use MAPE to compare time
series that use different units of measure.

MAXAE Maximum Absolute Error. MAXAE illustrates the
worst-case scenario for a forecast, expressed in the original
units of measure of the scenario.

MAXAPE Maximum Absolute Percentage Error. MAXAPE
illustrates the worst-case scenario for a forecast, expressed
as a percentage.

LOGLK Log Likelihood. LOGLK measures the accuracy of the
values in the time series, based on the data in the model.
With LOGLK, a larger value means a better fit.

MSE Mean Square Error. MSE measures the amount by which
the forecast deviates from the values predicted in the
model. MSE then squares the amount of the difference.
This action makes all of the values positive and gives more
weight to larger deviations.

RMSE Root Mean Square Error. RMSE measures the variation
between any subgroups in the forecast - for example,
this number can measure the variation between product
subgroups like mountain bikes and racing bikes. In
essence, RMSE returns the square root of MSE.
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Fit Statistic

Description

RSQ

R-squared. RSQ measures the proportion of the variation
between the demand model and the forecast. With RSQ, a
larger value means a better fit.

RSQ can return negative values. You can ignore any
negative values.

NRMBIC

Normalized Bayesian Information Criterion. NRMBIC
measures how the forecast fits the model; at the same time,
it takes the complexity of the model into account. NRBIC
is based on MSE, and the value returned by this statistic

is penalized for the number of parameters that the model
contains. This penalty levels the data - models with more
parameters no longer have any advantages over models
with fewer parameters. The result produces a statistic that
you can use to easily compare models in a time series.

AIC

Akaike Information Criterion. AIC tries to account for the
complexity of autoregressive models. Like NRMBIC, AIC
is penalized for the number of parameters that the model
contains.

BIC

Bayesian Information Criterion. BIC is based on the
negative value of the LOGLK statistic. Like NRMBIC and
AIC, BIC is penalized for the number of parameters that the
model contains.

Generated Forecasts

When you generate a forecast, the Forecast Studio displays the results in two ways:

 Using line graphs to illustrate the sales history and the statistical forecast in the Graph view.

* Numerically in the Time Series table.

The Model Statistics view also displays information about options and goodness of fit of the statistical model

that is used to generate a forecast.

Note. The Model Statistics view only displays information when you are in the Scenarios workspace.

Graph View

The Graph view displays a line graph over the period that is covered by the demand model, as well as the values
for the new forecast. In a generated forecast, the Graph view contains two or more curves as illustrated below:

22
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Forecast Studio Graph view

The curve on the left represents historical data (Sales History), while the curve on the right represents the
forecast data (Statistical Forecast). You can view graphs for individual demand points by selecting the
appropriate demand point from the Scenario View pane, or by using the dropdown menus on the Navigation bar.

If you edit the forecast, an adjusted forecast curve appears. This curve lies over the original historical data
curve.

You can also view information about individual points on the curve by holding the pointer over a specific
point. The annotation for the point on the curve displays:

* The time series to which the point belongs.

* The period that the point covers in the time series.

» The value or amount of the item (expressed in the unit of measure of the scenario) at that point in the
time series.

Time Series Table

Time Series table displays the historical information for the demand points in the forecast version, as well as
the corresponding information for the generated forecast. You can edit these fields in the Time Series table:

Field Explanation

Override Type The override to apply to the sales history or statistical
forecast. Valid options are:

* Absolute: Adds the specified value to the existing data.
Use negative values to subtract from the existing data.

» Relative: Multiplies the existing data by the specified
value. For example, to increase the forecast by ten
percent, specify 1.1.

» Replace: replaces the existing data with the specified
value.

Override The amount of the override.
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You edit the information in the Time Series table by selecting a value from the Override Type field and entering
the appropriate value in the corresponding Override field. Alternately, you can group-select values from the
Adjusted History values and make the desired changes from the appropriate right-click menu. These actions
affect both the adjusted forecast and the adjusted history, which is the series used by the forecasting engine
when generating forecasts. The original history series is not changed. You can also edit the adjusted forecast or
the adjusted history, and the Forecast Studio automatically calculates the override value.

Safety Stock

The Model Statistics view displays the safety stock values for a selected scenario. Safety stock is the amount
of supply below a minimum level that serves as a buffer against unexpected increases in demand.

When you select a demand point in the Scenario view, the Model Statistic view displays these values:
* Lead time.
* Service level.

» Standard deviation.
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Using the Forecast Studio

This chapter discusses how to:

« Start and log into the Forecast Studio.

* Open demand models and, optionally, select an aggregation hierarchy.

Starting and Logging into the Forecast Studio

In Windows, you start the Forecast Studio from the Start menu. In UNIX, you start the Forecast Studio from
the command line prompt. To obtain your Forecast Studio login information, contact the system administrator.

To start and log into the Forecast Studio:

1. Do one of the following:

From the Windows Start menu, select Programs, EnterpriseOne Supply Chain Planning 8.12, Demand
Management, Forecast Studio.

At the UNIX command line prompt, type this command:
path/common/scp/run dm forecast studio

Where path is the directory path (for example, /opt/scp/8.12) where EnterpriseOne Demand Forecasting is
installed.

2. Complete these fields:
* User ID.
» Password.

3. Click Login.

Loading Demand Models

Demand models form the basis of your forecasts. Demand models contain such information as products,
locations, and channels as well as aggregation and disaggregation information. You can create demand
models by:

* Manually creating the demand model in the Design Studio.

» Saving data from an external application in Extensible Markup Language (XML) format, and importing that
data into the database using the Demand Automation Shell.
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The first step in creating a forecast is to load a demand model into Forecast Studio.

Note. You can only open one demand model at a time.

To load demand models:
1. Select Open Demand Model from the File menu.
2. Select the demand model with which you want to work.

If you are using a specific aggregation hierarchy when forecasting with this model, select the hierarchy
from the Select Hierarchy drop down menu.

Note. If at any point you want to use a different aggregation hierarchy, you must close and re-load the
demand model.

4. Click OK to open the model.
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Working with Filters

This chapter provides an overview of filters and discusses how to:
» Work with filters
* Create custom filters.

* Use filter permissions.

Understanding Filters

Filters can be created and applied to the product, location, and channel drop-down lists in the Scenarios
workspace or the Forecast workspace. Filters can be very useful when a model contains many product,
channel, and location elements because they allow you to define which values are displayed and which

are hidden in these drop-down lists. Filters are user-based and can only be applied by those who have the
appropriate access rights. A filter is applied regardless of the current aggregation hierarchy level at which you
are browsing. For example, if you create a filter to view North American locations, you will only see North
American countries at the country level and North American regions at the region level.

Working with Filters
This section discusses how to:

* Create and save filters.

* Apply and unapply filters.
+ Edit filters.

* Rename filters.

* Delete filters.
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Windows Used to Work with Filters

Form Name Navigation Usage
Scenarios workspace Shortcuts Bar, Scenarios Displays the Scenarios
workspace
Filters workspace Shortcuts Bar, Filters Displays the Filters
workspace
Filters Tools, Edit Filters Select a filter to edit, rename
or delete.
Search In the Filter drop-down Create filters or edit the rules
list, select (Custom...). in existing filters.
You can also access
the Search window by
clicking the New button
or the Edit button in the
Filters window.

Creating and Saving Filters
Access the Filters window.
To create and save a filter:

1. Click the New button.
2. To add a new product rule, click the + Add Product Rule button.

A new product rule is created, and all of the Product properties defined in the model are populated in
the drop-down list on the left.

In the drop-down list on the left, select a Product property.
4. In the drop-down list on the right, select one of the following:
* is equal to
* is not equal to
* contains
* does not contain

5. Inthe blank field, enter a property value. If you click the icon to the right of this field, a list of all available
property values is displayed.

6. Click the + icon to add an OR statement to the product rule.
7. Click the + Add Product Rule button to add an AND statement to the product rule.
To add a new location rule, click the + Add Location Rule button.

A new location rule is created, and all of the Location properties defined in the model are populated in
the drop-down list on the left.

9. In the drop-down list on the left, select a Location property.
10. In the drop-down list on the right, select one of the following:

* is equal to
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11.

12.
13.
14.

15.
16.

17.

18.
19.
20.
21.

Working with Filters

* is not equal to
 contains
 does not contain

In the blank field, enter a location value. If you click the icon to the right of this field, a list of all available
location values is displayed.

Click the + icon to add an OR statement to the location rule.
Click the + Add Location Rule button to add an AND statement to the location rule.
To add a new channel rule, click the + Add Channel Rule button.

A new channel rule is created, and all of the Channel properties defined in the model are populated in
the drop-down list on the left.

In the drop-down list on the left, select a Channel property.
In the drop-down list on the right, select one of the following:
* is equal to

* is not equal to

* contains

* does not contain

In the blank field, enter a channel value. If you click the icon to the right of this field, a list of all available
channel values is displayed.

Click the + icon to add an OR statement to the channel rule.

Click the + Add Channel Rule button to add an AND statement to the channel rule.
In the Filter Name field, enter a name for the filter.

Click the Add Filter button.

Applying and Unapplying Filters

Access either the Scenarios workspace or the Forecast workspace.

All the filters that you have the right to apply are listed in the Filters drop-down list. To apply a filter, select it
from the Filter drop-down list.

Note. After you apply a filter, the data that is displayed in the main Forecast Studio workspace does not
change. What changes are the lists of items displayed in the Product, Location, and Channel drop-down lists,
which depends on the filter parameters that have been specified in the selected filter.

To apply a different filter, select a different filter in the Filter drop-down list.

To remove a filter:

1.
2.

Click the Filter drop-down list button.
Instead of selecting a filter, select the blank line above the (Custom...) filter.

This removes all filters. The Product, Location, and Channel drop-down lists are repopulated with all
items in those categories.
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See Also

Using Filter Permissions

Deleting Filters

Editing Filters

Access the Filters window.

To edit filters:

1.
2.

3. Make the appropriate changes to the filter in the Search window.

In the Filter Names list, select the filter that you want to edit.
Click the Edit button.
The Search window is displayed.

Close the Search window by clicking the OK button.

Select another filter to edit, or click the Close button.

Renaming Filters

Access the Filters window.

To rename filters:

wok wh =

In the Filter Names list, select the filter that you want to rename.

Click the Rename button.
Rename the filter in the Filter Names list.
Click Enter on the keyboard.

Select another filter to rename, or click the Close button.

Chapter 4

Note. Since filters can be made available globally, filter names must be unique in a demand model.

Deleting Filters

Access the Filters window.

To delete a filter:

1.
2.
3.

In the Filter Names list, select the filter that you want to delete.
Click the Delete button.

In the confirmation window, click Yes to confirm the deletion.

Creating Custom Filters

Access either the Scenarios workspace or the Forecast workspace.

30
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Working with Filters

Custom filters are filters that are not permanent and are not saved when you close out of Forecast Studio.
Custom filters can be useful when you want to quickly create and apply a filter.

To create a custom filter:

L.

10.

11.

12.
13.
14.

15.
16.

In the Filter drop-down list, select (Custom...)
The Search window is displayed.
To add a new product rule, click the + Add Product Rule button.

A new product rule is created, and all of the Product properties defined in the model are populated in
the drop-down list on the left.

In the drop-down list on the left, select a Product property.

In the drop-down list on the right, select one of the following:
* is equal to

* is not equal to

* contains

* does not contain

In the blank field, enter a property value. If you click the ... icon to the right of this field, a list of all
available property values is displayed.

Click the + icon to add an OR statement to the product rule.
Click the + Add Product Rule button to add an AND statement to the product rule.
To add a new location rule, click the + Add Location Rule button.

A new location rule is created, and all of the Location properties defined in the model are populated in
the drop-down list on the left.

In the drop-down list on the left, select a Location property.
In the drop-down list on the right, select one of the following:
* is equal to

* is not equal to

* contains

* does not contain

In the blank field, enter a location value. If you click the ... icon to the right of this field, a list of all
available location values is displayed.

Click the + icon to add an OR statement to the location rule.
Click the + Add Location Rule button to add an AND statement to the location rule.
To add a new channel rule, click the + Add Channel Rule button.

A new channel rule is created, and all of the Channel properties defined in the model are populated in
the drop-down list on the left.

In the drop-down list on the left, select a Channel property.
In the drop-down list on the right, select one of the following:
* is equal to

* is not equal to
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* contains
» does not contain

17. In the blank field, enter a channel value. If you click the ... icon to the right of this field, a list of all
available channel values is displayed.

18. Click the + icon to add an OR statement to the channel rule.
19. Click the + Add Channel Rule button to add an AND statement to the channel rule.
20. Click the Apply Filter button.

You can save a custom filter by entering a name in the Save as field before clicking the Apply Filter button.

Using Filter Permissions

Before users can apply, edit, or create filters, they must be granted the appropriate rights. These rights apply
to specific filters, not all existing filters. Contact your system administrator for more information about
filter permissions.

See Also

Granting Access to Filters
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Working with Scenarios

This chapter provides an overview of scenarios, lists prerequisites and discusses how to:

Create scenarios.

Compare scenarios.

Create what-if scenarios.
Import and export scenarios.
Manage scenarios.

Work with scenario notes.
Generate forecasts.

Edit generated forecasts.

Publish scenarios.

Understanding Scenarios

This section discusses:

* Scenarios.

* The Scenario Wizard.

* Scenario Comparison.

* What-if scenarios.

» Importing and exporting scenarios.

* Showing and hiding invalid demand points.
* Scenario management.

* Scenario notes.

* Forecast generation.

* Publishing scenarios.

Scenarios
Scenarios contain the information that populates a forecast, including (but not limited to):

* Product, location, and channel data.

+ Sales history information.
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* The unit of measure being used.

Using scenarios, you can isolate a single demand point or multiple demand points, and then use this information
as the basis for a forecast. You can create multiple scenarios to generate the optimal forecasts for your purposes.

You can create scenarios in the Forecast Studio using a wizard, and you can adjust the sales history information
in the Time Series table. You can also import and export scenarios from within the Forecast Studio.

The Scenario Wizard

The Scenario Wizard enables you to quickly create a scenario by walking you through the necessary steps.
With the Scenario Wizard, you can isolate a single demand point or multiple demand points, select a set of
coordinates, select sibling and children options, and then display a list of relevant demand points. Or, you

can filter based on the properties of demand points.

You can create a scenario for the demand point that is currently selected in the Forecast Studio. Although
creating a scenario for a single demand point is useful, it can limit the scope of your forecast. It is preferable to
create scenarios for multiple demand points.

You can also create a scenario for a set of demand points. Doing so enables you to select the group of
coordinates that you want to work with and then display a list of the relevant demand points. After you have
selected the appropriate coordinates, your scenario focuses on only the demand points that you want to
work with.

You can create a scenario for a set of demand points in the following ways:

» Use only the aggregation level that you specify by using the wizard.
* Use the siblings or children of the current aggregation level.

* Use a pre-defined demand point set.

Once you have a list of demand points, you can:

* Select specific demand points from the list to include in the scenario.
* Add all of the demand points in the list to the scenario.

As well, you can use a filter to return only a small subset of the demand points in a model. This enables you to
focus in on the demand points that you want to work with.

Using Filters

The demand points that the demand point set generator returns are based on the aggregation hierarchy of the
demand model that you are working with. You must search from the list of demand points that is generated to
find the demand points that you want to use in your scenario.

You can define a filter to quickly focus in on the demand points with which you or other users need to work.
When you define a filter, you use the rule builder to create a rule that produces a list of demand points that are
based on product, location, or channel attributes.

For example, you can define a filter that searches for a product or set of products that have these attributes:

* Available in a particular country or city.
* Have a certain word in the product name or description.

* Are sold by a specific customer.

The list of demand points that the filter returns is shorter than the one that is produced when you generate
demand points based on an aggregation hierarchy.
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Generating Scenarios in Base Unit of Measure for Leaf Demand Points

When generating scenarios, a demand point can only be defined for a single unit of measure. However, in most
cases your demand points have different units of measure. For example, a company has product families that
use either weight or volume as a unit of measure.

Use the Generate in Base Unit of Measure for Leaf Demand Points to define a scenario where the unit of
measure differs from the base unit of measure at aggregate levels. This is helpful since the primary purpose
of scenarios is for generating a statistical forecast.

Scenario Comparison
You can compare scenarios:
* Visually.

* In the Scenario Comparison window.

Visually Comparing Scenarios

You can visually compare scenarios in the Graph view or the Scenario Comparison view of the Forecast
Studio. Visually comparing scenarios enables you to quickly determine how the scenarios differ and which one
is best suited for your forecasting purposes.

The Graph view offers "at a glance" information about the scenarios in the form of a line graph that illustrates
both historical and forecast data. The Scenario Comparison view displays information about the statistical
model used to generate the forecasts, as well as statistics regarding the goodness of fit.

If you need detailed information about the scenarios, you should compare them using the Scenario Comparison
window.

Compare Scenarios in the Scenario Comparison Window

The Scenario Comparison window enables you to view and compare information about a demand point that is
used in multiple scenarios. You can compare only two scenarios at a time.

The upper portion of the window lists basic information about the demand model to which the scenarios
belong, including the current aggregation hierarchy, the demand point being compared, and the scenario
which is being used as the basis for the comparison. Each tab in the Scenario Comparison window contains
information about the scenarios being compared, as described below:

Tab Description

Statistical Model Displays this information for the scenarios being
compared:

« Statistical model used to generate the forecast
* The number of periods that form one seasonal pattern

» The names of the events, interventions, and predictors
that were used in the scenarios

Note that information appears on this tab only if the
ARIMA model was used to generate the forecast.
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Tab Description

Statistics Displays the fit statistics for each forecast, as well as
various safety stock parameters for each scenario and its
demand points. It also displays the differences between the
statistics and key performance indicators for each scenario.

Adjusted Sales History Displays the sales history for each date in the forecasting
horizon, along with the differences between the sales
histories of each scenario.

Generated Forecasts Displays the values of the generated forecasts in the
scenarios, along with the differences between the forecasts
that were generated for each scenario.

Adjusted Forecasts Displays the values of the adjusted forecasts in the
scenarios, along with the differences between the forecasts
that were generated for each scenario.

Note. You cannot edit any of the values that appear in the Scenario Comparison window.

After comparing the scenarios, you can:

* Compare the baseline scenario to another scenario.
* Publish the scenario that best suits your forecasting needs.

* Add or remove events, interventions, or outliers, and then compare the scenarios again.

What-If Scenarios

A what-if scenario enables you to perform a one-time comparison of two scenarios. By creating a what-if
scenario, you can increase the level of accuracy of your comparisons. The improved accuracy level is a result of
a comparison often only being valid if it is done from an exact duplicate of the scenario point being compared.

For example, you can use what-if scenarios to gauge the impact of a promotion on demand and inventory. The
promotion in question doubles demand for various products. If the promotion is modeled as an event and that
event is enabled in the baseline scenario (that is, the scenario containing the scenario point that you want to
copy), you can create a what-if scenario that does not have the event enabled.

Or, you can use a what-if scenario to compare the impact of outliers on a forecast. If the outliers are true
outliers - values in sales history that are much higher and lower than expected - then removing the outliers
will generate a better fit in the forecast.

To create a what-if scenario, you first copy a scenario point from your baseline scenario to a second scenario.
Once you have copied the scenario point, the results of the comparison are visible in the Scenario Comparison
view.

You should carry out any what-if comparisons with a scenario that you use exclusively as a workspace. You
can add or remove scenario points from this scenario without worrying that you will overwrite scenario points
in a working scenario. However, you should only use the scenario points that you need when performing a
comparison. Using too many scenario points increases the load on the Forecast Studio and can slow down
processing.
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When To Use What-If Scenarios

You will most frequently work with what-if scenarios at the beginning of a forecasting cycle, and after you
have published a forecast.

At the beginning of a forecasting cycle, you can use what-if scenarios to identify the outliers in a forecast. Once
you have identified the outliers, you can use the what-if scenario to test ways to repair the outliers. Or, you can
use a what-if scenario to model and test new promotions to gauge their effect on demand, inventory, and so on.

After you have published a forecast, you may receive updated information from another stakeholder - for
example, that there are errors in the forecast due to a product no longer being sold, a promotion being held
earlier in the cycle, and so on. Using this information and a what-if scenario, you can generate a forecast based
on the what-if scenario, and then publish that forecast to override the baseline forecast.

See Also
Working with Outliers

Import and Export Scenarios

Importing and exporting scenarios enables you to back up and restore scenario data, as well as transfer the
information to other instances of the Forecast Studio. By importing and exporting scenarios, you can persist
the information outside of the Forecast Studio and the database. When exported, the data is written to an
Extensible Markup Language (XML) file.

Importing scenarios is best done when you are at the beginning of a forecasting cycle and creating new
forecasts. Generally, you should not import an XML file in the middle of a forecasting cycle because doing this
overwrites data in an existing scenario, which can negatively affect your forecasts. However, there are times
when you might want to import an XML file during the forecasting process. For example, if you made changes
in a scenario that did not suit your needs, you can import an XML file to return the scenario to its original state.

Exporting scenarios is useful when you want to create a copy of a particular scenario for archiving. You can
also export a scenario to maintain a pristine copy of a scenario that you are working on in the Forecast Studio.
You can re-import the pristine copy if you make errors in your working copy.

Show and Hide Invalid Demand Points

In the Forecast Studio, all demand points are displayed in the Navigation bar by default. However, you might
not be able to access all of the demand points in the list. Any demand points that you cannot access are
considered invalid. Searching through a list that contains invalid demand points to find the ones to which
you have access can consume a lot of time. You can suppress the appearance of invalid demand points in the
Forecast Studio so that you can only view valid combinations of demand points.

Regardless of whether you want to edit or view demand points, showing invalid demand points can be a useful
navigation aid. After you show the invalid points, you can quickly navigate to other points in the demand
model using the Navigation bar.

Scenario Management

Scenario management is made up of five distinct tasks. These tasks enable you to work efficiently with
scenarios.

You can add demand points to a scenario to further refine your forecasts. The demand points that you add are
not specific to the scenario with which you are currently working; you can use them with other scenarios.

Using the Scenario Properties dialog box, you can refine your forecasts by editing these scenario properties:
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* Forecast Generation

The forecast generation parameters enable you to select a forecasting model on which to generate your
forecasts. You can also adjust the number of seasonal periods that might affect your forecasts.

 Safety Stock

Safety stock is the amount of supply above the forecasted level that serves as a buffer against unexpected
increases in demand. Many enterprises base their levels of inventory on the amount of safety stock they
have. However, you can also base your inventory on a specified level of service. This policy enables you to
base your inventory on the amount of service that you can offer a customer at a particular cost.

¢ Predictors

Time series that represent external, independent variables, such as the effect of a bad winter on orange
crops, or the effect of interest rates on housing starts.

¢ Events

Occurrences that take place at a regular interval - for example back-to-school sales, promotions or
giveaways, and the like.

* Interventions

One-time disturbances that cause a shift in demand.

You can specify a name for a scenario when you generate it using the Scenario Wizard. However, you can also
rename the scenario in the Forecast Studio to make the name more meaningful or descriptive.

If you discover that a scenario is not a good fit for a particular forecast or you made errors while defining
the scenario, you can delete it from the Forecast Studio. As well, you can delete specific demand points
from the scenarios.

See Also
Working with Predictors

Understanding with Events and Interventions

Scenario Notes

Notes are annotations made at a particular time bucket for a demand point. You add notes in the Scenarios view
in order to keep users informed about changes that have been made to a demand point during the forecasting
process. A user can navigate to a specific demand point and add a note that contains information about any
changes that were made to the demand point. Users with permissions to view the demand point can review
notes. Only users with write permissions to the demand points in a scenario can edit or delete notes.

Comments apply to the entire demand point. You add and view comments in the Forecasts view. Comments
can contain notes from a scenario if you specify that notes be added to comments when a scenario containing
notes is published.

You add notes to demand points in the Scenario Notes column of the Time Series table in the Scenarios view.
Each note can contain a brief description of any changes made to the demand point. After the scenario that
contains the demand point is published to a forecast version, all scenario notes can appear in the Consensus
Conference Room as annotations, or in forecast notes if specified during publish.

Note. For better readability, your notes should be as concise as possible.
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You can choose to append notes to lower level forecasts when using the top-down method of disaggregating
forecasts. When you select this option, notes from higher aggregation levels are added to notes in lower
aggregation levels.

See Also
Adding and Viewing Demand Point Annotations, Consensus Conference Room Implementation Guide
Exporting Scenarios

Forecast Notes

Forecast Generation

Once you have loaded sales history data into the Forecast Studio, you can generate a forecast. If one or more
demand points in the scenario are missing data, the Forecast Studio does not generate forecasts for those
demand points. For each demand point that cannot be forecast, Failed and the name of the forecasting model
being used when the failure occurred appears in the Model column of the Scenario Comparison view - for
example, ARIMA-Failed. An error message also appears for the first demand point that cannot be forecast.

Note. If a negative forecast value is returned for any demand point in the scenario, the value will appear
as zero in the Forecast Studio.

You should not generate a forecast for every demand point in a model because items in the model will not
aggregate properly because the are in a fixed state when you run the forecast. As well, if you have a large
model, it will take a quite a long time to generate a forecast.

You should generate a forecast at the lowest level of aggregation.

Editing Generated Forecasts

After you have generated a forecast, you might want or need to restate your data. You can restate data in
two ways:

* Changing the results graph.

* Specifying override values in the Time Series table.

By editing the values in the generated forecast, you can smooth out your data. If any one-off aberrations that
are outside the normal behavior of a demand model - for example, a natural disaster - occur, you can edit the
forecast to discount these events. You can also edit the data to account for shifts in behavior that cannot be
explained by the sales history of a product.

You can also edit the forecast data to reflect changes that are caused by a product’s life cycle. When a
new product is in its initial stages, sales increase as the popularity of the product increases. However, this
behavior does not continue. Eventually, demand for the product reaches a constant level and then tapers
off. If you are dealing with a new product, you can model the last two stages its life cycle to reflect when
demand inevitably levels off.

As well, you can edit the sales history before generating a forecast. This allows you to smooth your data so no
anomalies are included in the forecast.

Each scenario in a forecast uses a common sales history. However, when you edit a scenario, the overrides
only affect that scenario; they do not affect the common sales history.
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Publish Scenarios

Publishing a scenario adds the information in the scenario to a forecast version. This action makes the scenario
visible to other users of the Forecast Studio who have the rights to access this forecast version into which you
are publishing the scenario. You publish the scenario after you have generated a statistical forecast. Optionally,
you can also publish any notes that are attached to a scenario.

You can only publish the demand points to which you have write permission in a particular forecast version.
Any demand points to which you do not have write permissions are ignored. You will only see the forecast
versions to which you have write permissions in the list of forecast versions.

Note. Published scenarios overwrite any forecasts that the target forecast version currently contains.

Prerequisites

Before you can start working with scenarios, you must open a demand model and:

« If the demand model does not contain any sales history data, load the data.

* If the demand model does not have any scenarios, define at least two scenarios.
Before you can compare scenarios, you must:

 Ensure that the scenarios that you want to compare were created using the same aggregation hierarchy.

* Generate a forecast for each scenario that you want to compare before performing the comparison.

Creating Scenarios
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This section discusses how to:

 Create scenarios for one demand point.
 Create scenarios for a set of demand points.
 Create scenarios using a filter.

* Create scenarios for a pre-defined demand point set.

Windows Used to Create Scenarios

Form Name Navigation Usage
Forecast Studio Change Level, Select a Select a demand point on
demand point. which to base a new scenario.
Scenario Wizard Shortcuts bar, Scenarios, Starts the Scenario Wizard,
Edit, New Scenario. where you create a new
scenario.

Creating Scenarios for One Demand Point

Access the Scenario Wizard window.
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To create scenarios for one demand point:

1. Complete these fields:
* Scenario Name
* Unit of Measure
2. Select the Create the scenario for the current demand point option.

This option bases the demand point on the aggregation level that you selected from the Change Level
area of the Forecast Studio.

3. Select the Generate in base unit of measure for leaf demand points option.

This option enables you to generate the forecast for the demand point using only the base unit of measure
for that demand point.

4. Click Finish.

Creating Scenarios for a Set of Demand Points

Access the Scenario Wizard window.
To create scenarios for a set of demand points:

1. Complete these fields:

* Scenario Name

* Unit of Measure
2. Select Create the scenario for a set of demand points option.

This option enables you to generate a set of demand points for the scenario with which you are working.
3. Select the Generate in base unit of measure for leaf demand points option.

This option enables you to generate the forecast for the demand points using only the base unit of measure
for those demand points.

4. Click Next.

Complete the Aggregation Level field.
6. Complete these fields:

* Product

* Location

* Channel
7. Select one of these options:

* This Demand Point Only

This option enables the user to access the demand point specified by the combination of product,
location, and channel.

* Include Siblings

This option enables the user to access the specified demand point and any demand points that are on
the same aggregation level.
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10.
I1.
12.

* Include Children

This option enables the user to access the specified demand point and any demand points that are
under it. You can specify the number of levels to use below the current demand point by selecting a
number from the Level(s) drop-down list.

Click Filter.

Do one of the following:

* Click Add all.

* Select the demand points that you want to use, and then click Add selected.
Repeat steps 3 to 9 for each demand point for which you want to grant user access.
Click Finish to save the changes and exit.

Click Yes to save the changes.

Creating Scenarios Using a Filter

Access the Scenario Wizard window.

To create scenarios using a filter:

1.
2.
3.

Click Demand Points by Property.
Complete the Property Name field with the property that you want to use for filtering.
Complete the Rule field.
You can select from these options in the drop-down list:
* is equal to
Only demand points containing the exact criteria in the Property Value field are included in the list.
* not equal to

All demand points, other than the ones containing the exact criteria in the Property Value field, are
included in the list.

* contains

Demand points are included in the list if they contain the criteria in the Property Value field.
* does not contain

All demand points except those containing the criteria in the Property Value field are included in the list.
Complete the Property Value field, and click OK.

You can type the filtering criteria in the field or click the button next to the field and select a value from
the dialog box that appears. Click the plus-sign button beside the Property Value field to add a property
value to a rule. Entering additional property values enables you to specify multiple values for a particular
property name and to filter on one value or the other.

Click Add Rule and repeat steps 2 to 4 for each new filter that you want to define.
Click Filter.

3. Do one of the following:

* Click Add all.
* Select multiple demand points, and then click Add selected.
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4. Click Finish.
5. Click Yes to save the changes.

Creating Scenarios for a Pre-Defined Demand Point Set
Access the Scenario Wizard window.
To create scenarios for a pre-defined demand point set:

1. Complete these fields:
* Scenario Name.
* Unit of Measure.
2. Select Create the Scenario from a Pre-Defined Demand Point Set.
In the Demand Point Set drop-down list box, choose a demand point set.
4. Optionally, select the Generate in Base Unit of Measure for Leaf Demand Points option.

This option sets leaf level demand points to the base unit of measure as demand points at an aggregate level
might require a different unit of measure for forecasting.

5. Click Finish.

Comparing Scenarios

This section discusses how to:

* Visually compare scenarios.

* Use the Scenario Comparison view.

Windows Used to Compare Scenarios

Form Name Navigation Usage

Forecast Studio View, Graph View a line graph that
illustrates the historical
demand and the forecast
for a scenario.

Forecast Studio View, Scenario Comparison Compare multiple scenarios.

Forecast Studio Tools, Compare Scenario Displays the Compare
Scenario dialog box.

Visually Comparing Scenarios
Access the Graph view.

To visually compare scenarios, select the scenarios that you want to compare.
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Using the Scenario Comparison View

Access the Compare To dialog box.

To compare scenarios in the Scenario Comparison view:

Chapter 5

1. Select the scenario against which you want to make the comparison in Compare to Scenario, and then

click OK.

2. When you have finished comparing the scenarios, click Close.

Creating What-If Scenarios

This section lists a prerequisite and discusses how to create what-if scenarios.

44

Prerequisite

Before you can work with what-if scenarios, you must create an empty scenario.

Windows Used to Create What-If Scenarios

Form Name

Navigation

Usage

Forecast Studio

Shortcuts bar, Scenarios

View the Scenarios
workspace.

Forecast Studio

View, Scenario View

List the demand points in the
currently selected scenario.

Forecast Studio

Edit, Copy Scenario Point

Copy the currently selected
scenario point to another
scenario.

Scenarios Pane

Select a scenario.

Select the scenario that you
want to use as the basis for

the comparison.

Creating What-If Scenarios

Access the Scenario view and the Copy to dialog box.

To create what-if scenarios:

1. Select the scenario to which you want to copy the scenario point from the drop-down list, and then click OK.

If the scenario point that you are copying exists in the target scenario, the Forecast Studio displays an

Crror message.

2. Click Yes to copy the scenario point; otherwise, click No.

Select Generate for Selected Demand Points only from the Tools menu to forecast the effects of the
copied scenario point on the scenario.

4. Select Scenario Comparison from the View menu.
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Importing and Exporting Scenarios

This section discusses how to import and export scenarios.

Windows Used to Import and Export Scenarios

Form Name Navigation Usage

Forecast Studio Shortcuts bar, Scenarios Perform tasks in the
Scenarios workspace.

Scenarios Pane Select a scenario. Select the scenario that you
want to use as the basis for
the comparison.

Forecast Studio Edit, Import Scenario Import scenario information
from an XML file.

Forecast Studio Edit, Export Scenario Export scenario information
to an XML file.

Importing Scenarios
Access the Import Scenario dialog box.
To import scenarios:

1. Navigate to the directory containing the scenario that you want to import.
2. Select the XML file that contains the scenario information that you want to import into the Forecast Studio.
3. Click Open.

Exporting Scenarios
Access the Export Scenario dialog box.
To export scenarios:

1. Navigate to the directory where you want to save the scenario.
2. In the File Name field, type a name for the scenario.
3. Click Save.

Showing and Hiding Invalid Demand Points
This section discusses how to show and hide invalid demand points in a scenario.
To show and hide invalid demand points:

1. Select Show Disabled Coordinates from the View menu.

2. Select Show Disabled Coordinates again to display invalid demand points.
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Managing Scenarios

This section discusses how to:

46

* Add demand points to scenarios.

 Edit scenario properties.

* Delete demand points from scenarios.

¢ Rename scenarios.

* Delete scenarios.

Windows Used to Manage Scenarios

Form Name

Navigation

Usage

Forecast Studio

Shortcuts bar, Scenarios

Perform tasks in the
Scenarios workspace.

Scenario workspace

View, Scenario view

List the demand points in the
currently selected scenario.

Scenario workspace

Tools, Scenario Properties

View details of the
forecasting model, safety
stock, outliers, predictors,
and events used with the
scenario.

Scenarios Pane

Select a scenario.

Select the scenario with
which you want to work.

Scenarios Pane

Select a demand point.

Select the demand point with

which you want to work.

Adding Demand Points to Scenarios

Access the Scenario workspace.

To add demand points to scenarios, click the Add to Scenario button on the toolbar.

Deleting Demand Points from Scenarios

Access the Scenario workspace.

To delete demand points from scenarios, click the Remove from Scenario button on the toolbar.

Editing Forecast Generation Parameters

Access the Scenario Properties dialog box.

To edit forecast generation parameters:

1. Select a forecasting model from the Forecasting Model drop-down list.

2. In the Seasonality field, select the number of periods for a seasonal cycle.
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3. Click OK.

Note. The Model Parameters area of the dialog box displays the service level that you set on the Safety
Stock tab of the Scenario Properties dialog box. You can adjust the properties of multiple demand points
in a scenario by selecting the demand points in the Scenario view.

See Also

Understanding Forecasting Models

Editing Safety Stock Parameters

Access the Scenario view, and then the Scenario Properties dialog box.

To edit safety stock parameters:

1. Click Safety Stock.

2. In the Total Lead Time (periods) field, select the number of periods required to restock an item.
You can set a maximum of 99 periods.

3. Enter a percentage of time during which you want customer orders to be fulfilled on time in the Desired
Service Level field.

The higher the service level, the more expensive it is to provide the specified level of service because
you must carry more inventory to balance out any uncertainty. You can vary the service level depending
on the customer.

4. Select one of these options:
» Use system calculated standard deviation
The Forecast Studio calculates the amount by which forecasts deviate from the actual demand.
 User defined standard deviation
The user specifies the amount by which forecasts deviate from the actual demand.
5. Click OK.

Renaming Scenarios
Access the Scenario view.
To rename scenarios:

1. Select the scenario that you want to rename, and then choose Rename Scenario from the Edit menu.

2. Enter a new name for the scenario, and then press Enter.

Deleting Scenarios
Access the Scenario view.
To delete scenarios:

1. Select Delete Scenario from the Edit menu.

2. Click Yes to delete the scenario.
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Working with Scenario Notes
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This section discusses how to:

* Add notes to demand points.
* Delete notes from demand points.

¢ Show and hide notes.

Windows Used to Work with Notes

Form Name Navigation Usage

Forecast Studio Shortcuts bar, Scenarios Perform tasks in the
Scenarios workspace.

Scenarios workspace View, Time Series List the sales history and
forecast information for the

scenario on a monthly basis.

Time Series Table Select a demand point Highlight to demand point
that you want to work with.

Adding Notes to Demand Points
To add notes to demand points:

1. Double-click the Note field, and type the note.

2. Enter or click in another field.

See Also

Publishing Scenarios

Deleting Notes from Demand Points
To delete notes from demand points:

1. Double-click the Note field.

2. Drag the mouse pointer over the note text, and then press Delete.

Showing and Hiding the Scenario Notes Column

Because the Time Series table in the Forecast Studio contains a considerable amount of information,

occasionally you may need to view only some of the columns in the table. To simplify your tasks, you can

show or hide the Scenario Notes column in the Time Series table.

To show and hide the Scenario Notes column, right-click any field in the Time Series table and select Notes

from the shortcut menu that appears.
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Generating Forecasts

This section discusses how to:

» Generate a forecast for an entire scenario.

* Generate a forecast for one or more demand points in a scenario.

Windows Used to Generate Forecasts

Form Name Navigation Usage
Forecast Studio Shortcuts bar, Scenarios Perform tasks in the
Scenarios workspace.
Scenarios workspace Select a scenario. Highlight the scenario on
which you want to base the
forecast.

Generating Forecasts for a Scenario

Access the Scenarios workspace.

To generate forecasts for a scenario, select Generate for Scenario from the Tools menu.

A graph appears in the Graph View area, and the forecast data appears in the Time Series Table. If the time
series table is not visible, click the Show or Hide Time Series Table button on the toolbar.

Generating Forecasts for a Selected Demand Point

Access the Scenarios workspace.

To generate forecasts for a selected demand point, select Generate for selected Demand Point(s) only from

the Tools menu.

Editing Generated Forecasts

This section discusses how to:
+ Edit the Results graph.
» Edit the Time Series table.

+ Edit sales history information.

+ Edit forecast history information.
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Windows Used to Edit Generated Forecasts

Form Name Navigation Usage

Forecast Studio Shortcuts bar, Scenarios Perform tasks in the

Scenarios workspace.

Scenarios workspace View, Graph View a line graph that

illustrates the historical
demand and the forecast
for a scenario.

Scenarios workspace View, Time Series List the sales history and

forecast information for the
scenario on a monthly basis.

Editing the Results Graph

Access the Graph view.

To edit the results graph:

1.

Click and drag the highlighted demand point up or down, depending on how you want to edit that point.

A dark line appears in the original path of the curve, denoting the locations of the points before the
data was overridden.

From the Tools menu, select one of these options to apply the changes:

* Generate for Selected Demand Point(s) Only.

» Generate for Scenario.

Editing the Time Series Table

Access the Time Series table.

To edit the Adjusted History or Adjusted Forecast columns in the Time Series table:

1.
2.

Find the value that you want to edit in the table.

Select one of these options from the Override Type drop-down menu:

Absolute

This is a value that the Forecast Studio adds to the current value in the Sales History field of the Time
Series table. For example, if the Sales History field contains the value 533.71 and you type 23.29 in the
Override field, the value in the Adjusted History field becomes 557.

Relative

The system uses the percentage difference. You specify this amount by using a decimal. To specify a 10
percent difference, for example, you type 1.1.

Replace

The system uses the value that is specified in the Override field instead of the value in the Sales History
field.

In the Override field, type a value for the option that you select from the Override drop-down menu.

The value that you type in this field changes the contents of the Adjusted History field.
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4. Repeat steps 2 and 3 for each value that you want to edit.

To remove any changes made to the Override column, select the values that you want to change and
from the right-click menu select Reset.

5. To make changes to multiple Adjusted History or Adjusted Forecast values, do the following:
* Multi-select the values that you want to change.
* Move the cursor out of the last selected cell and place the pointer on another selected cell.
* From the right-click menu select the appropriate override type.
6. Select one of these options from the Tools menu to apply the changes:
* Generate for Selected Demand Point(s) Only.

» Generate for Scenario.

Editing Sales History Information

Access the Scenarios workspace.

Note. You must be at the lowest level of aggregation and have administrative privileges in order to edit
sales history information.

To edit sales history information:
Select the aggregation level containing the demand point whose sales history you want to edit.
In the Time Series table, find the value that you want to edit in the Sales History column.

Double-click on the field containing the value that you want to edit.

bl e

Enter a new value in the field, and then press Enter.

Editing Forecast History Information

Access the Forecasts workspace.

Note. You must be at the lowest level of aggregation and have administrative privileges in order to edit
forecast history information.

To edit forecast history information:
Select the aggregation level containing the demand point whose forecast history you want to edit.
In the Time Series table, find the value that you want to edit in the Sales History column.

Double-click the field containing the value that you want to edit.

Sl .

Enter a new value in the field, and then press Enter.

Publishing Scenarios

Access the Scenarios workspace.

To publish scenarios:
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Select the forecast version to which you want to publish the scenario from the Publish forecasts to forecast
version drop-down list.

Select one of these options:
* Publish the forecast for the current demand point only.
* Publish forecasts for all demand points in the Scenario.

If you also want to publish the notes in the scenario to the specified forecast version, select one of these
options:

Publish scenario notes to comments

Comments are similar to notes, but they apply to the entire demand point and can only be read in the
Forecasts view. Use this option to add the notes in the scenario to the comments for the target forecast
version.

» Publish scenario notes to forecast notes
Makes the notes visible in the Forecast Notes column of the Table view of the Forecasts view.
» Append scenario notes to forecast notes

If notes exist in the forecast version into which the scenario is published, selecting this option adds the
notes in the scenario to the notes in the forecast version. If you do not select this option, the existing
forecast notes are overwritten with the notes from the scenario.

To publish the notes in the scenario, you must have write permissions to the demand points that contain
notes.

Note. If you do not have write permissions to some or all of the demand points that contain notes, an
error message appears indicating the number of notes that cannot be written to the database.

Users with read permissions to the forecast version to which are you publishing the scenario can view the
scenario notes as annotations in the Consensus Conference Room.

5. Click OK.
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Working with Ad Hoc Queries

This chapter provides an overview of ad hoc queries, and discusses how to work with ad hoc queries.

Understanding Ad Hoc Queries

This section discusses:

* Ad hoc queries.

* Creation of ad hoc queries.

* Execution of ad hoc queries.

» Disaggregation of ad hoc queries.

* Duplication of ad hoc queries.

» Export of query forecasts and query sales histories.

* Query properties.

Ad Hoc Queries

Using ad hoc queries, you can use any criteria to search the database for items. They are called ad hoc
queries because the search is based on individual properties that exist in the demand model but that might not
exist together in any single aggregation hierarchy.

You can use ad hoc queries to view or edit a forecast for a product or a group of products based on the
properties that you specify. For example, you can create a query to report on a single SKU for all independent
channels in a particular region. When you run the query, the forecasts for the queries that you define appear in
the Table and Graph views of the Forecast Studio.

When a property that is used by a query is renamed in the Design Studio, the change is automatically
propagated to the query. However, you must reopen the demand model in the Forecast Studio to refresh the
property names with the updated values.

Although you can generate ad hoc queries from within the Forecast Studio, there are also Demand Automation
shell commands available for doing batch queries.

Creation of Ad Hoc Queries

You create ad hoc queries with a wizard. Creating ad hoc queries involves selecting a list of demand points
that you want to query. You select the demand points to use in a query from a list of demand points that are
based on product, location, or channel attributes.
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For example, you can define a filter that searches for a product or set of products that have the following
attributes:

* Available in a particular country or city.
» Containing a particular word in the product name or description.

* Sold by a specified customer.

The list of demand points that the filter returns is shorter than the one that the system returns when you
generate a list of demand points based on an aggregation hierarchy. Valid demand points have a check mark
beside them. Invalid demand points have a cross beside them.

When you create an ad hoc query, you select one or more forecast versions to use with the query. Only forecast
versions to which you have access appear in the query wizard. If you do not have access to a forecast version,
it will not appear in the results in the Query pane.

When defining queries, you can group several together. When you group queries, you select the properties
that are used to aggregate query results. For example, you can group queries by product name and location
to aggregate query results using those properties.

Execution of Ad Hoc Queries

After you define ad hoc queries, you run them periodically. If any information changes in the demand model
with which you are working, running the queries updates the information in the query, and then query will
be run.

You can run valid ad hoc queries only. To be valid, a query must contain all units of measure and all demand
points specified in the query parameters. If any of the units of measure or demand points of a valid query are
deleted, you can no longer run the query. However, you can export the last set of query results.

After you run the query, a graph can be displayed in the Graph view. The Table view is populated with data for
each of the forecast versions in the query. The data in this view is based on Row and Column configurations.
Column data is represented in the X-axis and Row data is represented in the Y-axis.

Note. Sales history can only be viewed when both Forecast Version and Time are selected in the Row and
Column drop-down lists.

When you create a query, you can specify groupings for the query results. If you specify groupings, you can
select the grouping properties in the drop-down lists in the Data Selection pane.

Note. Because ad hoc queries are specific to forecast versions, only forecast versions to which you have access
appear in the results. If the query is invalid, a message appears to indicate that the query cannot be run.

When a property that is used in a query is deleted in the Design Studio, that query is no longer valid. The query
property page in Forecast Studio will contain a message indicating the reason why the query is no longer valid.

See Also

Exporting Query Forecasts

Disaggregation of Ad Hoc Query Forecasts

After you generate forecasts based on an ad hoc query, you can disaggregate those forecasts. You can only edit
and disaggregate queries that you have run.
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Note. Queries can only be edited for specific query coordinates. If (All) is selected in any of the drop-down
lists in the Data Selection pane, the query cannot be edited.

See Also

Forecast Disaggregation

Duplication of Ad Hoc Queries

You cannot edit queries. However, you can duplicate a query. Duplicating an ad hoc query makes a copy of a
query and its parameters. Duplicating a query is useful if, for example, you want to use the same query criteria
for a product at a different location in the supply chain.

Note. You can duplicate invalid queries.

See Also

Creating Ad Hoc Queries

Export of Query Forecasts and Query Sales Histories

The information in a demand model is rarely static. Data in the demand model changes, and will affects ad
hoc queries. As data changes, you might need to maintain a record of the results from past queries. You
can do this by exporting query results.

The sales histories in a query can be exported to a file that contains the following information:
» The query properties used to aggregate the query results.

* The date.

* The value of the forecast on a particular date.

You can save the query forecasts and query sales histories in these formats:

* A comma separated values (CSV) file with the extension .csv.

The CSV file is a flat file containing information in tabular format. You can import the CSV file into any
spreadsheet or database application, like Microsoft Excel.

* An XML file with the extension .xml.

Using the Extensible Stylesheet Transformation Language (XSLT), you can transform the XML file to such
formats as HTML (for viewing in a web browser) or Adobe PDF (for printing).

When exporting query results, you can select forecast versions whose sales histories are exported with the
query.

Note. You cannot export query forecasts if:
You do not have access to any of the forecast versions in the query.

The query has not been run.
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Query Properties

Unless you have created a particular query, it is difficult to determine the purpose of a particular query simply
by looking at it in the Query workspace. By viewing the properties of a query, you can view the purpose of the
query and its criteria.

You view query properties in the Query Properties window:

|§ Query Properties ﬂ

General IF::-reu:ast"v"ersiDns | Parameters |

ﬁﬂ IT:::ru:untu:u Bikes

nit of Measure:  Daollars

Ewecution Time:  2004-04-23 16:10:53

Dezcription: S ales information for bikes sold at all channels in Toronta

Aftributes; ¥ walid ¥ | Erecution Rights

Query Properties window
The Query Properties window consists of the following three tabs:

¢ General

This tab provides a basic description of the query, the base unit of measure, an indication of whether the
query is valid, and information about permissions to run the query. If a query is invalid, the Valid check box
on the General tab is cleared.

* Forecast Versions
This tab lists the forecast versions used in the query.
* Parameters

This tab lists the query criteria and describes how the elements of the query are grouped. A check mark
appears beside all valid query criteria. A cross appears beside all invalid query criteria.
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Creating Ad Hoc Queries

This section discusses how to:

* Create ad hoc queries.

* Run ad hoc queries.

* Duplicate ad hoc queries.

* Disaggregate ad hoc query forecasts.

» Export ad hoc query forecasts.

» Export ad hoc query sales histories.

* View ad hoc query properties.

* Rename ad hoc queries.

* Delete ad hoc queries.

Windows Used to Work with Ad Hoc Queries

Form Name Navigation Usage

Query Workspace Shortcuts Bar, Queries Perform tasks in the Queries
workspace.

Query Wizard Edit, New Query Starts the Query Wizard,
where you define the criteria
for ad hoc queries.

Disaggregate Query Edit, Disaggregate Query Disaggregates the forecasts
generated by a query.

Creating Ad Hoc Queries

Access the Query Wizard window.

Note. You can also create ad hoc queries using the import queries DASH command.

To create ad hoc queries:

Click Next.

Eall e

Enter a descriptive name for the query.

(Optional) Enter a detailed description of the query.

Do one of the following:

* Select the base unit of measure for the query from the Unit of Measure drop-down list.

* Select one or more forecast versions. The query uses the forecast history from the selected forecast
versions when you run the query.

5. Click Next.

6. Complete the Property Name field with the property that you want to use for filtering.
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8.
9.

10.
I1.
12.
13.
14.

Complete the Rule field.
You can select from the following options in the drop-down list box:
* is equal to
Only demand points containing the exact criteria in the Property Value field are included in the list.
* not equal to

All demand points, other than the ones containing the exact criteria in the Property Value field, are
included in the list.

* contains
Demand points are included in the list if they contain the criteria in the Property Value field.
* does not contain
All demand points except those containing the criteria in the Property Value field are included in the list.
Complete the Property Value field and click OK.
Click Add Rule and repeat steps 9 and 10 for each new filter that you want to define.
(Optional) Click Preview.
Click Next.
Select the query properties that you want to use to group the results.
Click Next.

Review your selections.

If the query is satisfactory, then click Finish. Otherwise, click Back to modify the query.

Running Ad Hoc Queries

Access the Query Workspace window.

To execute ad hoc queries, select Execute Query from the Tools menu.

Duplicating Ad Hoc Queries

Access the Query Workspace window.

To duplicate ad hoc queries:

wok wh

Select the query that you want to duplicate, and then select Duplicate Query from the Edit menu.
Enter a new name for the query in the Name field.

Enter a new description for the query in the Description field.

Click Next.

(Optional) Do the following:

* Select a new base unit of measure for the query from the Unit of Measure drop-down list.

* Select one or more new forecast versions. The query uses the forecast history from the forecast versions
that you select.

Click Next.
Do the following:
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9.

10.
11.
12.

Working with Ad Hoc Queries

* Add or delete properties.

* Add or delete rules.

(Optional) Click Preview.

Click Next.

Select the query properties that you want to use to group the results.
Click Next.

Review your selections.

If the query is satisfactory, then click Finish. Otherwise, click Back to modify the query.

Disaggregating Query Forecasts

Access the Query Workspace window, select the query that you want to disaggregate, and then access the
Disaggregate Query dialog box.

To disaggregate query forecasts:

1.
2.

4.

Select the forecast version on which you want to base the disaggregation.

To disaggregate only the query demand points that have changed since you created the query, select
the Only modified query points option.

Select one of the following disaggregation modes:
* Disaggregate using system profile.

» Disaggregate using own profile.

Click OK.

Exporting Query Forecasts

Access the Query Workspace window, and select the query containing the results that you want to export.

To export query forecasts:

1.
2.

Select Export Query Forecasts from the Edit menu.

Select one or more forecast versions to use.

Select an output format for the query forecasts.

Valid options are XML and CSV.

Enter a name and path for the file in the Please enter output name field.
You do not have to include a file extension.

Click Export.

Exporting Query Sales Histories

Access the Query Workspace window.

To export query sales histories:

L.

Select the query containing the sales history that you want to export.
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2. Select Export Sales History from the Edit menu.
Select an output format for the results.
Valid options are XML and CSV.

4. Enter a name and path for the file in the Please enter output name field.
You do not have to include a file extension.

5. Click Export.

Viewing Query Properties
Access the Query Workspace window.
To view query properties:

1. Select the query whose properties you want to view.
2. Select Query Properties from the Tools menu.

Review the Query Properties window to determine if the query suits your needs and, if you have the
permissions, run it.

3. Click Close.

Renaming Queries
Access the Queries workspace.
To rename queries:

Select the query that you want to rename.
Select Rename Query from the Edit menu.

Enter a new name for the query.

el S

Press Enter to save the changes.

Deleting Ad Hoc Queries
Access the Queries workspace.
To delete ad hoc queries:

1. Select the query that you want to delete.
2. Select Delete Query from the Edit menu.
3. Click OK.
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Working with Forecast Versions

This chapter discusses how to:

* Work with forecast versions.

» Working with forecast notes and comments.

* Work with publishing profiles.

Understanding Forecasts and Forecast Versions

This section discusses:

Forecasts.
Forecast versions.
Forecast notes.
Comments.

Sales history.

Product, location, and channel information.

Demand point initialization.

Approval of demand points.

Cleared demand points.

Import and export of forecast versions.
Fixed forecasts.

Comparing forecasts.

Forecast disaggregation.

Forecast balancing.

Forecasts

Forecasts are projections of future demand for a particular item. Using information in a demand model in

conjunction with the sales history information for the same demand model, you can forecast the demand for a
product at various points in the future.

Forecasts consist of:

Forecast versions.
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* A container for forecast data in a specific demand model.

Each forecast version is associated with a demand model and is owned by the user who created it.
* Scenarios.
* The information that is used to populate a forecast.

This information includes product, location, and channel data; sales history; the unit of measure; and so
on. By defining scenarios, you can isolate a single demand point or multiple demand points and use this
information as the basis for a forecast.

After you have entered all the required data, you can run the forecast based on a specific scenario. This action
generates a graph that you can use to compare the forecast to the historical data. From this point, you can
publish the scenario to a forecast version, which stores the scenario in the database.

Although you can add forecast versions to a demand model, you can only view, edit, or reconcile the forecast
versions to which you have been granted access rights. Any forecast versions to which you do not have access
rights are visible but unavailable for viewing or editing.

Forecast Versions

Forecast versions act as containers for forecast data in a specific demand model. Each forecast version is
associated with a demand model. The Forecast Studio user who created a particular forecast version also has
permissions to read and write to the forecast version and to make it consistent.

When you create a forecast version, it uses the data structure of the demand model. However, any changes that
you make to the data do not affect the demand model. If you are satisfied with the results that are produced by
the forecast version, you can add this information to the database. Otherwise, you can delete it.

The user who creates a forecast version has read, write, and reconcile permissions for it. However, no other
users have permissions to the forecast version. A user with administrative privileges can assign permissions to
other users in the User Manager.

Forecast Notes

Notes and comments enable you to keep track of the changes made to demand points. While they may seem
similar, notes and comments are treated differently in a demand model.

Notes are annotations made at a particular time bucket for a demand point. You add notes in the Forecasts view
in order to keep users informed about changes that have been made to a demand point during the forecasting
process. A user can navigate to a specific demand point and add a note that contains information about any
changes that were made to the demand point. Users with permissions to view the demand point can review
notes. Only users with write permissions to the demand points in a forecast version can edit or delete notes.

Comments apply to the entire demand point. You add and view comments in the Forecasts view. Comments
can contain notes from a scenario and a forecast version.

You add notes to demand points in the Forecast Notes column of the Time Series table in the Forecasts
view. Each note can contain a brief description of any changes made to the demand point. You can copy
forecast notes to comments.

Note. For better readability, your notes should be as concise as possible.

See Also

Scenario Notes
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Comments

Like notes, comments enable you to keep track of the changes made to demand points. While they may seem
similar, notes and comments are treated differently in a demand model.

Comments apply to the entire demand point. You add and view comments in the Forecasts workspace.
Comments can contain notes from a scenario and a forecast version.

You add comments to demand points in the Forecasts view. Each comment consists of a subject, followed by
the actual comment. After you save comments, they appear in the Consensus Conference Room as annotations.

You add comments using the Add Comment dialog box. In addition to containing fields for the subject and
body of the comment, the Add Comment dialog box also displays:

* The forecast version to which the comment is being added.

» The demand point in the forecast version to which the comment will be added.

Note. The comments that you add in the Forecast Studio can be viewed in the Consensus Conference Room as
annotations. Conversely, any annotations that are added in the Consensus Conference Room can be viewed in
the Forecast Studio as comments.

Not all forecast versions have comments associated with them. Because comments are associated with
demand points at a particular aggregation level, you may have to navigate to that aggregation level in order
to view the comments.

You can copy forecast notes to comments in the Forecasts workspace.

See Also
Consensus Conference Room Implementation Guide, “Adding and Viewing Demand Point Annotations”

Publishing Scenarios

Sales History

Generating accurate forecasts is difficult when using only current forecast data because past factors have a
direct impact on forecast data. Sales history data consists of trade promotion, out-of-stock history, seasonality,
and market trend information.

Because sales history is also input into the forecasting engine and into the generated forecast, it can affect
the validity of forecast data. Therefore, the sales history data must be accurate. If you use inaccurate sales
information, your forecasts will also be inaccurate.

Sales history is also used to determine forecast accuracy by comparing historical data with forecast data that is
projected for the future. Historical data can help to determine consistencies and inconsistencies in the forecast
because spikes and valleys in the data indicate that some type of activity has occurred.

When comparing forecast data for a time series, sales history can reveal additional information that enables
you to determine if the data is accurate. Forecast data is often based on patterns from previous years. If a sales
history pattern shows an increase in product sales for a particular period, this pattern might not always fall in
the same time period every year; therefore, it cannot be captured as seasonal data.

You can import existing sales history data into a demand model from within the Scenarios workspace in the
Forecast Studio and use it to generate statistical forecasts and compare current forecast data. You can view the
data in either graph mode or table mode.
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Sales history data must be viewed in the same time bucket as the current forecast data that already exists in
the database, such as daily, weekly, or monthly buckets. You might have to use the scrolling feature in
graph mode if the start date of the sales history occurs before any forecast data and there are large gaps
between the demand points.

Product, Location, and Channel Information

The aggregation hierarchy defines the structure of a model. At the lowest level of the hierarchy are demand
points for each location where you sell a product into a channel. Higher levels in the aggregation hierarchy
are defined by choosing a product, a location, and a channel grouping.

Successively higher aggregation levels are built from successively higher product, location, and channel levels.
At each aggregation level, you obtain aggregation points that are the intersection point for all of the values
from the product, location, and channel levels (each level has successively fewer aggregation points than

the one below it). The demand at any aggregation point is calculated by aggregating the demand from the
next lower aggregation level.

An aggregation point is a demand point that appears in the aggregation hierarchy. All aggregation points are
demand points, but all demand points are not aggregation points. An aggregated value can be calculated in
many ways, depending on how you define the various hierarchies. The cross-product of all points in the
product hierarchy, location hierarchy, and channel hierarchy define all of the possible demand points.

For example, suppose that a model contains this data:

* Product: Service Parts/Misc/Primer

* Location: Germany/Berlin/Alles Bikes/

* Channel: Independent

Using the product, location, and channel level, you can display specific data for particular demand points.

The combination of product, location, and channel level creates a demand point where potential for demand
exists. Each demand point at the top of the aggregation hierarchy and follow the path down until you reach the
point that has a unique place within the aggregation hierarchy-in this case, the bottom-most level. The data for
this demand point is displayed in the Scenario View area.

Note. An ellipsis before a product, location, or channel field is a placeholder for any folders that are part of
the navigation path but don’t appear in the field.

Demand Point Initialization

New demand points that you introduce into a demand model do not have a sales history associated with
them. Initializing demand points enables you to generate sales history data for any new demand points in a
demand model. By initializing demand points, you are working with a subset of products, locations, or
channels. The initialization process is useful when you have many new demand points, but you need to
work with only a few of them.

Initializing demand points also enables you to model the sales history for a product, location, or channel, based
on the actual history of a similar product, location, or channel. When you generate a statistical forecast, the
new demand points require historical data. For example, assume that you introduce into your line a new
product that is based on an existing product. The new product does not have a sales history. However, you can
use the sales history from the existing product to model the history of the new product.

You initialize demand points in the Initialize Demand Points window in the Forecast Studio. Initializing
demand points enables you to:

Copyright © 2006, Oracle. All rights reserved.



Chapter 7 Working with Forecast Versions

* Select the demand point to filter.
* Specify sales history information for each product, location, or channel in the demand point.

* Generate a sales history for the demand point.

Here is the Initialize Demand Points window:

— Mew Demand Points
Froduct Marne I Location MName I Charrel Mame I Status -
Extreme Bike, Green Bike Sport 1 bl azs Market M
Extreme Bike, Green Bike Sport 2 bl azs Market M
Extreme Bike, Green ketro Bike 1 bl azs Market M
Extreme Bike, Green Shopmart 2 bl azs Market M
Extreme Bike, Red Bike Sport 1 bl azs Market e LI
— Target Demand Pointz Filker
— Salez Higtory Generator
Wieight Product Mame Location Mame Channel Mame
1
2
3
4
]
— Matched Demand Pointz
Product Mame Location Mame Channel Mame Statusg
[T Display Dz Filker Generate Clear Approve Cloze |
Vo

Initialize Demand Points window
The Initialize Demand Points window consists of these areas:

* New Demand Points
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This area lists all of the demand points in the demand model that are flagged as New. Product names that
appear in bold represent demand points that are completely new.

* Target Demand Points Filter

You use this area to define the demand points for which you want to model sales history information.
* Sales History Generator

You use this area to specify the demand points that supply the sales history information for the new products.
* Matched Demand Points

This area lists all of the demand points that match the criteria that you specified in the Sales History
Generator area.

After you generate sales histories for the demand points, the Initialize Demand Points window displays
demand points in an expandable tree. The demand points that provide the history information are listed beneath
the new demand points, as shown in this image:

Product M arne | Location M ame: | Chatinel Marme I Status I
E]--EE:u:tleme Bike, Red Bike Sport 1 tasz Market Generated i
- Frame, Green QOutdoar Life 1 tasz Market
: - Touring Bike, Green Bike Sport 1 tasz Market
-- Extreme Bike. Red Bike Sport 2 tasz Market Generated
-- Extreme Bike, Red Metro Bike 1 b azs Market Generated
- Extreme Bike, Red Shopmart 2 tasz Market Generated

Initialized demand points in the Forecast Studio

The Initialize Demand Points window also displays a graph that illustrates the modeled sales history for each
demand point. This image shows a sample graph:

000 *

I . VAN A
S M T S AN AN

1]

S O O Y L |
2000-01-01 Z000-06-01 2000-11-01 Z001-04-01 2001-09-01 2002-02-01 2002-07-01 2

Initialized demand points graph

Note. You might have to filter and generate demand points multiple times before you achieve satisfactory
results.

See Also

Introducing New Products into Demand Models,Design Studio Implementation Guide

Approval of Demand Points

After you have modeled the history for the demand points, you can approve them. When you approve a
demand point, you clear the New flag for that demand point.

Note. You can exit the Initialize Demand Points window before you approve a demand point, and review the
history in the Forecast Studio views. When you reopen the Initialize Demand Points window, the demand
points that you generated are still available for revision.

Copyright © 2006, Oracle. All rights reserved.




Chapter 7 Working with Forecast Versions

Cleared Demand Points

If you are dissatisfied with the sales history that you have modeled for any of the demand points, you can clear
it. Any demand points for which you have cleared the sales history are removed from the list in the Matched
Demand Points area of the Initialize Demand Points window.

Import and Export of Forecast Versions

You can save and load files containing forecast version information to or from a local or network drive. The
files containing forecast version information are in XML format and have the extension .xml. The XML files
that you export encapsulate all of the information in a forecast version.

Note. Depending on the size of the data model, the forecast version files can be quite large and can take
some time to import and export.

Fixed Forecasts

Forecast data that is published to the database at a particular demand point is referred to as fixed. After
you upload, view, and compare the forecast data, you might decide to make some changes to some of
the values. Forecast data that is not aligned with other stakeholder forecast data might be incorrect and
may need adjustment.

Note. Aggregation occurs automatically up the hierarchy until a fixed value is encountered. The aggregation
does not overwrite any fixed values.

Comparing Forecasts

From within the Forecasts workspace you can compare baseline forecast version data with other forecast
versions. By comparing forecasts you can better understand the baseline forecast version data in relation
to other stakeholder forecasts.

When comparing forecasts, actuals appear in the time series table as shaded, and forecast values appear
unshaded. As you add forecasts that you want to compare, the appropriate columns are added to the time series
table. Only the baseline forecast can be edited, and you must have the appropriate permissions.

Forecast Disaggregation

Disaggregating forecasts enables you to compare forecast data that was forecasted at a higher level with
another user’s data that was forecasted at a lower level of abstraction.

You can disaggregate a forecast in three ways:
» Using the system profile.

» Using the current forecast version profile, in top-down mode.

» Using the current forecast version profile, in bottom-up mode.

Disaggregation Using the System Profile

Disaggregating a forecast using the system profile causes the Forecast Studio to distribute forecast data
upwards according to the underlying pattern in the current forecast version. To perform the disaggregation,
the Forecast Studio copies leaf demand points from the system profile into the working profile. The values
and forecasts in the system profile replace those in the working profile. Only leaf demand points from the
system profile are used in disaggregation.
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The value in each time bucket adds up to the value of the top-level forecast, and all existing proportions remain
intact after disaggregation. These proportions are taken from the system forecast version.

You can disaggregate with the system profile if little or no data is at the lowest level of the current forecast
version. In the Forecast Studio, the name of the system profile appears in parentheses beside this option.

In addition, any negative values are treated as 0 in the working profile. Negative values retain their original
values in the system profile.

Top-Down Disaggregation Using the Current Profile

Top-down disaggregation distributes the forecast data downwards from the highest aggregation level according
to the underlying pattern in the current forecast version. The value in each time bucket adds up to the value
of the parent forecast.

If there are no forecasts at the lower levels of aggregation, the Forecast Studio creates forecasts at those levels
and then performs the disaggregation. If some of the demand points at the lower levels have forecasts and
others do not, the values being pushed down from the top are split between the demand points that have
forecasts. The demand points without forecasts are ignored.

All fixed points beneath the top level are overwritten, except for leaf demand points. If there are missing
values, then the top value is evenly distributed at the lowest level. In addition, missing values at the lowest
level of aggregation are ignored.

Depending on the quality of your data, however, disaggregation may not work exactly in this manner. Several
special cases can affect results, including these:

* When the parent forecast has a missing value in a time bucket, this value is forced downwards to all children
regardless of the values that they previously had.

« If all children in a particular bucket have a value of 0, the value of the parent forecast is distributed evenly
among them.

» All missing values are considered missing as long as at least one value in the pyramid is greater than 0.
« If all values below the parent forecast are missing, then the Forecast Studio registers them as missing.
* Negative values are treated as 0.

* If some child demand points have missing values and others have data, the Forecast Studio only
disaggregates the demand points that contain data.

Bottom-Up Disaggregation Using the Current Profile

Bottom-up disaggregation distributes forecast data upwards from the lowest aggregation level according to the
underlying pattern in the current forecast version. Leaf-level demand points are copied from the system profile
into the working profile. The values that were originally in the working profile at the leaf level are ignored.

Depending on the quality of your data, however, disaggregation may not work exactly in this manner. Several
special cases can affect results, including these:

If all child demand points in a particular bucket have missing values, they are assigned equal values so that
their sum is equal to the value of the parent forecast.

* A forecast is created for any demand points that do not have a forecast associated with them.
» All negative values are treated as O.

* When some of the demand points in a time bucket have missing values, those demand points are ignored.
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More Information About Disaggregation

Regardless of the disaggregation option that you use, the changes that result from disaggregation are
propagated to all units of measure that apply at the level of disaggregation. All fixed demand points demand
points become unfixed, and the changes are displayed in the Table view.

You disaggregate forecasts by using the Disaggregate Forecast(s) dialog box. On the Disaggregate Forecast(s)
dialog box, you select the options to use when disaggregating a forecast:

e Forecast version
e Unit of measure
» Aggregation level

* Forecast version profile

You can also specify whether to leave a forecast in the fixed state. By default, the Forecast Studio leaves
forecasts that are fixed in the same state after disaggregation. Forecasts that are not fixed remain unfixed.
Generally, you fix forecasts after disaggregation, because any forecast that is not fixed is not taken into
account during the reconciliation process.

Forecast Balancing

Sometimes, the values of the child data in a forecast do not add up to the value of the parent data. The
Forecast Studio enables you to balance a forecast so that you can eliminate these inconsistencies and obtain the
necessary data. Balancing a forecast essentially makes the forecast consistent.

By balancing a forecast, you minimize any errors in that forecast, and you create a well-formed forecast that is
better suited to your needs. This process assigns new weights to the values in both the main forecast and its
forecast versions, and this ensures that the values of the forecast version add up to the value of the forecast.

For example, assume that you have forecast that the demand for a particular product will be 1,000 units.
The three child forecasts have values of 300, 370, and 280 units, respectively-totaling 950. Balancing the
forecast assigns new weights to the value of the parent forecast and the values of the child forecasts so
that the values add up correctly.

You can balance forecasts based on:

* The current demand point

Balances the forecast based on the demand point that is currently active in the Forecast Studio. To balance
all of the forecasts that are above the current demand point, select the Unfix forecast above option.

» The aggregation level

Balances the forecast based on an aggregation level that you select from the drop-down menu.

After you balance the forecast, the Forecast Studio saves the results to the database. You cannot roll back
the changes. Any negative values remain negative.

Note. You can only use the Balance Forecast function if you have reconciliation permissions for the forecast
version that you are working with. Contact your system administrator to confirm that you have reconciliation
permissions for the forecast version.

Working with Forecast Versions

This section discusses how to:
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* Add forecast versions to

a demand model.

* Rename forecast versions.

* Delete forecast versions.

* Select the Baseline View Forecast Version.

» Compare forecast versions.

* Import sales histories.

* Change product, location, and channel.

* Initialize demand points.
* Approve demand points.

* Clear demand points.

* Import and export forecast versions.

* Fix forecasts.
» Disaggregate forecasts.

* Balance forecasts.

Windows Used to Work with Forecasts

Form Name

Navigation

Usage

Forecast Studio

Shortcuts bar, Forecasts

Perform tasks in the Forecast
'Versions workspace.

Forecast Studio

Shortcuts Bar, Scenarios,
Edit, Initialize Demand
Points

Generate sales history data
for any new demand points.

Forecast Studio

Edit, Import Forecast Version

Start the process for
importing forecast version
information from an XML
file.

Forecast Studio

Tools, Balance

Make a forecast consistent.

Time Series Table

Select a demand point.

Highight the demand point
with which you want to
work.

Adding Forecast Versions to a Demand Model

Access the Forecasts workspace.

To add forecast versions to a demand model, select New Forecast Version from the Edit menu.

Chapter 7

A new forecast version appears on the Forecasts tab. You can change the name of the forecast version

to make it descriptive.

Renaming Forecast Versions

Access the Forecasts workspace.
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To rename forecast versions:

1. Select the forecast version that you want to rename.
2. Rename Forecast Version from the Edit menu.

3. Enter a new name for the forecast version, and then press Enter.

Deleting Forecast Versions
Access the Forecasts workspace.
To delete forecast versions:

1. Select the forecast version that you want to delete.

2. Select Delete Forecast Version from the Edit menu.

Selecting the Baseline Forecast Version

Depending upon the permissions that are granted to you by the system administrator, you can view your
own forecast version and at least one other forecast version. When comparing forecasts, you can only edit
the baseline forecast. Changing the baseline forecast version allows you to use different forecast versions
as the benchmark for forecast data comparison. This ability provides you with different perspectives on
the forecast data.

To select the baseline forecast version:

Select the name of the forecast version that you want as the baseline forecast version from the drop-down list
in the Forecasts View.

Comparing Forecast Versions
Access the Forecasts workspace.
To compare multiple forecasts:

1. Select a forecast version that you want to view from the Baseline View.

2. Select all of the forecast versions that you want to compare by choosing the option that is next to the
forecast version.

Importing Sales Histories
Access the Forecasts workspace.
To import sales histories:

1. Select Import Sales History from the Edit menu.
2. Navigate to the directory containing the sales history file that you want to import.
3. Select the sales history file, and then click Open.

Changing Product, Location, and Channel Information
Access the Forecasts workspace.

To change the product, location, and channel levels that you want to view, select:
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¢ Product.
¢ Location.

* Channel.
The data in the Graph view and Time Series table reflects the new aggregation level.

To change product, location, and channel information, select the demand point from the Aggregation Level
drop-down list. The valid options depend on the demand model with which you are working.

The corresponding available product, location, and channel appear in the Product, Location and Channel
drop-down list.

Depending on the item that you select, the information in the Graph view and in the Sales History column of
the Time Series table reflects your selection.

Initializing Demand Points

Access the Initialize Demand Points window.
To initialize demand points:

1. Select the product, location, and channel that you want to initialize from the respective drop-down lists in
the Target Demand Points Filter area of the Initialize Demand Points window.

Alternatively, you can use multiple products, locations, or channels for filtering by using the asterisk as
a wildcard character.

2. For each unique combination of product, location, and channel, type the weighting in the Weight % field.

By specifying a weighting, you can set the percentage of the sales history from the sources to use. For
example, you can specify 30 percent from one combination of product, location, and channel, and 70
percent from another combination. The weightings do not have to equal 100 percent. For example,
assume that a new location is in an area that is twice the size of the location on which you are modeling
the new location. In that case, you can expect demand and sales to be twice as great in the new location.
Therefore, you would type 200 in the Weight % field.

3. Click Filter.

Note. Alternatively, you can perform this step after you have specified the target demand points that you
want to filter. When you do this, any weightings that are generated apply to the source demand points only.

4. Select one or more demand points, and then click Generate.

Note. You can select the Display IDs option to review information by product IDs instead of by product
names.

Approving Demand Points
Access the Initialize Demand Points window.
To approve demand points:

1. Select the product name.

2. Click Approve.
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If the demand point does not have sales history associated with it, a warning message appears. Click Yes to
approve the demand point.

Clearing Demand Points
Access the Forecasts workspace.
To clear demand points:

1. Select the demand points whose sales history you want to clear.
2. Click Clear.

Importing Forecast Versions

Access the Import Forecast Version window.
To import forecast versions:
1. Navigate to the directory containing the forecast version file that you want to export.
2. Select the file containing the forecast version, and then click Open.
3. Select a disaggregation mode:
 Disaggregate using system profile.
 Disaggregate using current forecast version profile and top-down disaggregation mode.

 Disaggregate using current forecast version profile and bottom-up disaggregation mode.
4. Click OK.

Exporting Forecast Versions
Access the Forecasts workspace.
To export forecast versions:

Select the forecast version that you want to export.
Export Forecast Version from the Edit menu.

Select a folder in which to save the forecast version.

b=

Enter a name for the forecast version in the File Name field, and then click Save.

Note. Specify the extension .xml with the file name.

5. Clear any of the following export options:
* Include Aggregated Demand Points.
* Include Missing Demand Points.
* Include Annotations.

6. Ifyou have a slices file-which lists the specific demand points that you want to export from a demand model
so you do not export the entire forecast version-and you want to attach it to the export, click Slices File.

7. Navigate to the directory containing the slices file.

8. Select the slices file, and then click Open.
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0.

Click OK.

Fixing Forecasts

Access the Forecasts workspace.

To fix forecasts:

1.
2.
3.

Select the forecast version to fix from the Forecasts tab.
In the Scenario view, select one or more demand points.

Select Fix Forecast from the Tools menu.

Disaggregating Forecasts

Access the Forecasts workspace.

To disaggregate forecasts:

el S

Select the forecast to disaggregate from the list.

Select Disaggregate Forecast from the Tools menu.

Select the forecast version that you want to disaggregate from the Forecast Version drop-down menu.
Select a unit of measure from the Unit of measure drop-down menu.

The default is the unit of measure that is currently selected in the Forecasts workspace.
Select one of the following options:

* Current Demand Point

» Aggregation Level.

Select the aggregation level to use from the drop-down list.

Select a disaggregation mode:

 Disaggregate using system profile.

 Disaggregate using current forecast version profile and top-down disaggregation mode.

Note. To automatically append notes during top-down disaggregation, select the Append Forecast
Notes option.

» Disaggregate using current forecast version profile and bottom-up disaggregation mode.

If the forecast is fixed and you want unfix it, select the Unfix all forecasts above demand points in scope
option.

Click OK to disaggregate the forecast.

Balancing Forecasts

Access the Balance Forecasts dialog box.

To balance levels:

1.
2.

74

Select the forecast that you want to balance from the Forecast Version drop-down list.

Select one of the following options:
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e Current Demand Point

You can also select the Unfix forecasts above option.

» Aggregation Level

Select an aggregation level from the drop-down list.

Click OK.

4. In the warning dialog box that appears, click Yes.

Working with Forecast Versions

Working with Forecast Notes and Comments

This section discusses how to:

* Add notes to demand points.

* Delete notes from demand points.

» Show and hide notes.

* Add comments to demand points.

* View comments.

» Copy notes into comments.

Windows Used to Work with Forecast Notes

Form Name

Navigation

Usage

Forecast Studio

Shortcuts bar, Forecasts

Perform tasks in the
Forecasts workspace.

Forecasts workspace

Select a forecast

Highlight the forecast with
which you want to work.

Forecasts workspace

Edit, Copy Notes into
Comment

Copy the notes in a forecast
into the comments for that
forecast.

Forecasts workspace

Edit, Add Comment

Add a new comment to a
forecast.

Adding Forecast Notes to Demand Points

To add forecast notes to demand points:

1. Click the Forecast Notes field, and type the note.

2. Enter or click in another field.

Deleting Forecast Notes from Demand Points

To delete forecast notes from demand points:

1. Click the Note field.
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2. Drag the mouse pointer over the note text, and then press Delete.

Showing and Hiding the Forecast Notes Column

Because the Time Series table in the Forecast Studio contains a considerable amount of information,
occasionally you may need to view only some of the columns in the table. To simplify your tasks, you can
show or hide the Forecast Notes column in the Time Series table.

To show and hide the Forecast Notes column, right-click any field in the Time Series table and select Forecast
Notes from the shortcut menu that appears.

Adding Comments to Demand Points
Access the Add Comment dialog box.
To add comments to demand points:

1. Complete these fields:
* Subject
* Comment

2. Click OK to save the comment

Viewing Comments

When a forecast version contains demand points with comments associated with them, a paper clip icon
appears beside the name of the forecast version.

To view comments, select Show Comment from the Edit menu.

A dialog box appears listing all of the comments associated with the demand point.

Copying Forecast Notes into Comments

Access the Copy Notes into Comment dialog box.
To copy forecast notes into comments:
1. Select one of the following options:
* Copy Forecast Notes to Comments for All Demand Points.

* Copy Forecast Notes to Comment for Current Demand Point only.
2. Click OK.

Working with Publishing Profiles
This section provides an overview of publishing profiles and describes how to:

* Create a publishing profile
* Publish a publishing profile
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 Edit a publishing profile
* Delete a publishing profile

Working with Forecast Versions

EnterpriseOne Demand Forecasting is a decision support tool which enables you to plan for and meet future
demand by creating on accurate business forecasts. You can create meaningful schedules, production plans,
and financial plans to meet that demand. You can also create and run publishing profiles that allow you to
publish a configurable set of plans to an external location.

These publishing profiles contain standardized publish actions that can be used to commit a plan during any
session. Profiles determine which plans to publish and they also allow you to initiate an integration process
with an external system. You can refine your publishing preferences by editing an existing profile, or by
creating a new profile for a specific business need.

Note. The publish process is not intended to generate reports.

Windows Used to Work With Publishing Profiles

Create a publishing profile from the Forecasts workspace:

* File, Publish.
e Click New.

Publish a profile from the Forecasts workspace:

* File, Publish.
* Click Publish.

Edit a publishing profile from the Forecasts workspace:

* File, Publish.
* Click Edit.

Delete a publishing profile from the Forecasts workspace:

« File, Publish.
* Click Delete.

Creating a Publishing Profile

Access the Create a Publish Profile window.

To create a publishing profile:

1. Complete the following fields:

Profile Name
Description
Format

Output File

Copyright © 2006, Oracle. All rights reserved.

Specify a unique name for the publishing profile.
Optionally, specify a description for the publishing profile.
Select the format that will be used for publishing the data.

Specify the directory where the system will save the published data. You
can explicitly specify the location of the directory or click Browse to
browse for a directory.
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2. Optionally, specify a script that will be initiated after the data is published. You can explicitly specify the

location of the script or click Browse to browse for a script.
Select the Data Selection Tab.

4. Select a forecast version.

5. Click OK.

Publishing Data Using Profiles
Access the Publish window.
To publish data using a profile:

1. In the Profiles list, select the profile that you want to publish.
2. Click Publish.

Editing Publishing Profiles
Access the Edit Profile window.

To edit a publishing profile:

1. Edit the fields in the General and Data Selection tabs as applicable.

2. Click OK to save your changes to the profile.

Deleting Publishing Profiles
Access the Publish window.
To delete a publishing profile:

1. In the Profiles list, select the profile that you want to delete.
2. Click Delete.
3. Click Yes to confirm that you want to delete the profile.
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Working with Range Profiles

This chapter provides an overview of range profiles, and discusses how to:

» Work with range profiles

* Manage range profiles.

Understanding Range Profiles

This section discusses:

» Range forecasting.

» Range alerts.

» Forecasts outside the flex fence.

» Export and import of range forecasts.
» Export of range profile alert reports.

» Range profile management.

Range Forecasting

Range forecasts enable you to compare multiple statements of demand across a forecasting horizon. You can
generate optimistic, pessimistic, and most likely forecasts and visually compare and contrast them.

You do this by creating a profile that defines a flex fence. The flex fence specifies the lower-most and
upper-most levels of variation within a forecast for a particular period. The range profile is applied to the last
period’s sales history. If there is no sales history, no flex fences are generated. Using a flex fence, you can
better manage large variations in demand.

You work with range forecasts in the Range Profiles workspace. The range forecasting process consists of
these tasks:

* Creating range forecasting profiles.

» Applying range forecasting profiles.

* Viewing range forecasts.

* Identifying forecasts outside of range.

* Importing and exporting range forecast information.
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Create Range Profiles

When you create a range profile, you are creating an empty shell into which you add the demand points that
will make up the range profile. The empty range profile consists of a name for the profile, a unit of measure to
use, and an optional description. Once you have created a range profile, you must assign demand points to it.

The flex fence is defined in the Table view of the Ranges workspace. In Table view, you can define the
lower-most and upper-most levels of variation within the forecast.

Assign Demand Points to Range Profiles

You assign demand points to a range profile with a wizard. Demand point assignment involves selecting the
specific demand points that you want to assign to a range forecast. For example, you can define a filter that
searches for a product or set of products that have the following attributes:

* Available in a particular country or city
* Have a certain word in the product name or description
* Are sold by a specific customer

The list of demand points that the filter returns is shorter than the one that is produced when you generate a list
of demand points based on an aggregation hierarchy. Valid demand points have a check mark beside them.
Invalid demand points have a cross beside them.

Range Alerts

After you have defined a range profile and assigned demand points to it, you can generate range alerts. A range
alert indicates that there is demand for a product that lies outside of the flex fence.

You view the range alerts information in the Range Alerts view of the Forecasts workspace. The Range Alerts
view displays the following information:

* The demand points that contain demand that is outside of the flex fence.
* The name of the range profile being used.

* The number of alerts that were generated for each demand point.

The following screen shows the Range Alerts view:

Product Location Channel F ange Profile Total Alerts
: O ptimniztic
O ptirmiztic
/Recreational/BicyclesMountain Bike, Red  /Canada’vVancouver/Outdoor Life 3 /Maszs Market  Ophimistic 1
/Recreational/Bicycles/Touring Bike, Green  /CanadavVancouver/Outdoor Life 3 /Maszs Market  Ophimistic 12
/Recreational/Bicycles/Touring Bike, Red  /Canada’Vancouver/Outdoor Life 3 /Mass Market  Ophimiztic 10

The Range Alerts view

Forecasts Outside the Flex Fence

Forecasts outside of the flex fence appear in the Graph view, and are indicated by chevrons. This image shows
range forecasts outside of the flex fence as they appear in the Graph view.
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The Graph view displaying range forecasts outside of the flex fence

You can view the alerts in the Graph view by clicking on the demand point in the Range Alerts view. The
upper and lower ranges of the flex fence are represented by blue dotted lines in the Graph view. You can
choose to display either the upper or lower ranges.

Export and Import of Range Profile Data

You can save both the structure of a range profile and the range profile demand point set assignments to an
XML file. You can do this to back up this information, or to share it with another EnterpriseOne Demand
Forecasting user in your enterprise. You can also restore backed up range profile information, or import
information from another forecaster, from an XML file.

Export of Range Profile Alert Reports

You can save the information about alerts in a range profile to an XML file. You can do this to save range
profile alert information for later comparison. The report contains the following information:

* The demand points outside of the flex fence.
* The amount by which those demand points are outside of the flex fence.
» The forecast versions that contain the demand points.

* The name of the range profiles being used.

Range Profiles Management
Range forecast management consists of the following tasks:

* Duplicating range profiles.
* Renaming range profiles.

* Deleting range profiles.
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You cannot edit range profiles. However, you can duplicate profiles. Duplicating a range profile makes a
copy of the profile and its parameters. A duplicate is given the name "Copy of<profile name>", where<profile
name>is the base profile. For example, "Copy of Pessimistic." Duplicating a range profile is useful if, for
example, you want to use the same range profile criteria for a product at a different location in your supply
chain.

Renaming a range profile is useful when you want to give that profile a more descriptive name, or if you need
to change the name of a range profile that you have duplicated.

Working with Range Profiles
This section discusses how to:

* Create range profiles.

» Assign demand points to range profiles.

» Import and export range profiles.

» Import and export range profile demand point assignments.
* Generate range alerts.

* View demand points outside of the flex fence.

» Export range profile alert reports.
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Windows Used to Work with Range Profiles

Form Name

Navigation

Usage

Range Profiles workspace

Shortcuts Bar, Range Profiles

Displays the Range Profiles
workspace.

New Range Profile

Edit, New Range Profile

Displays the New Range
Profile window, where
you can enter the basic
information for a range
profile.

Assign Range Profile

Edit, Assign Range Profile
Demand Points

Displays the Assign Demand
Points window, where you
select the demand points that
you want to use with the
profile.

Import Range Profile
Definitions

Edit, Import Range Profiles

Displays the Import Range
Profile Definitions dialog
box, which enables you to
import range profiles from an
XML file.

Export Range Profile
Definitions

Edit, Export Range Profiles

Displays the Export Range
Profile Definitions dialog
box, which enables you to
export range profiles to an
XML file.

Import Range Profile
Demand Point Assignment

Edit, Import Range Profile
Demand Point Assignment

Displays the Import Range
Profile Demand Point
Assignment dialog box,
which enables you to import
range profiles demand point
set assignment information
from an XML file.

Export Range Profile
Demand Point Assignment

Edit, Export Range Profile
Demand Point Assignment

Displays the Export Range
Profile Demand Point
Assignment dialog box,
which enables you to Export
range profiles demand point
set assignment information
to an XML file.

Range Alert View

Forecasts, View, Range
Alert View

Displays the Range Alert
view, which lists the number
of alerts in each demand

point.

Creating Range Profiles
Access the New Range Profile dialog box.

To create a new range profile:

1. Enter a name for this profile in the Name field.
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A

Select a unit of measure to associate with the profile from the Unit of Measure drop-down list.
Optionally, type a short description of the profile in the Description field.
Click OK.

In the Table view of the Ranges workspace, define the flex fence by typing values in the Upper Range and
Lower Range columns of the table. The values must be entered as factors. For example, a 10% increase
must be entered as 1.1 and a 10% decrease as 0.9.

Assigning Demand Points to Range Profiles by Hierarchy
Access the Assign Range Profiles dialog box.

To assign demand points to range profiles by hierarchy:

L.

S kW

Complete these fields:

» Aggregation Level

* Product

* Location

* Channel

Click one of these options:
* This Demand Point Only

This option enables the user to access the demand point specified by the combination of product,
location, and channel.

* Include Siblings

This option enables you to access the specified demand point and any demand points that are on the same
aggregation level. This option is disabled if you have chosen the top/top/top aggregation level.

* Include Children

This option enables you to access the specified demand point and any demand points that are under it.
You use the Level(s) drop-down list to specify the number of levels below the current demand point.

Click Filter.
To add specific demand points to the set, select the demand points and then click Add.
To add all of the demand points to the set, click Add all.

If the demand points have units of measure assigned to them, you can click the Allow to overwrite the
existing assignment option to replace the unit of measure assignment with the unit of measure used
by the range profile.

Click OK.

Assighing Demand Points to Range Profiles by Property

Access the Assign Range Profiles dialog box.

To assign demand points to range profiles by property:

1.
2.

84

Click the Demand Points by Property tab.

Click Add Rule to create a new rule.
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Working with Range Profiles

Select the appropriate items from the drop-down lists:
* Name
Select Aggregation Level. You use the aggregation level to base your query on.
* Function. You can select from these options in the drop-down list:
is equal to
Only demand points containing the exact criteria in the Property Value field will be included in the list.
not equal to

All demand points, other than the ones containing the exact criteria in the Property Value field, will
be included in the list.

Contains
Demand points will be included in the list if they contain the criteria in the Property Value field.
does not contain

All demand points except those containing the criteria in the Property Value field will be included
in the list.

Complete the Property Value field either by typing the filtering criteria in the field, or clicking the button
that is beside the field and choosing a value from the dialog box that appears.

Note. Click the plus button beside the Property Value field to add an additional property value to a rule.
Adding more property values enables you to specify multiple values for a particular property name, and
filter on one value or the other.

Repeat steps 2 to 4 for each rule that you want to add.
Click Filter to generate a list of demand points.
Select the demand points that you want to associate with the event, and then click Add.

If the demand points have units of measure assigned to them, you can click the Allow to overwrite the
existing assignment option to replace the unit of measure assignment with the unit of measure used
by the range profile.

Click OK to save the changes.

Generating Range Alerts

Access the Forecasts workspace and display the Range Alerts view.

To generate range alerts, select Generate Range Alerts from the Tools menu.

The range alert information appears in the Range Alerts view.

Viewing Demand Points Outside of the Flex Fence

Access the Forecast workspace.

To view demand points outside of the flex fence, right-click in the Graph view and select the following
options from the pop-up menu:

» Upper Range.

* Lower Range.
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» Range Exceptions.

Exporting Range Profile Alert Reports
Access the Forecasts workspace.
To export range profile alert reports:

1. Select Export Range Profile Alert Reports from the Edit menu.

2. In the Export Range Profile Alert Report dialog box, navigate to the directory where you want to save
the report.

3. Enter a name for the report in the File name field. You do not have to include an extension for the file.
4. Click Save.

Viewing Range Alerts in the Graph View
Access the Range Alerts view.
To view range alerts in the Graph view, select a demand point in the Range Alerts view.

Any forecasts outside of the flex fence are indicated by chevrons.

Managing Range Profiles

This section discusses how to:

* Rename range profiles.
* Duplicate range profiles.

* Delete range profiles.

Renaming Range Profiles
Access the Range workspace.
To rename range profiles:

1. Select the range profile that you want to rename.
2. Select Edit, Rename Range Profile.

3. Enter a new name for the range profile, and then press Enter.

Duplicating Range Profiles
Access the Ranges workspace.
To duplicate range profiles:

1. Select the range profile that you want to duplicate.
2. Select Edit, Duplicate Range Profile.
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Enter a name for this profile in the Name field.

3
4. Select a unit of measure to associate with the profile from the Unit of Measure drop-down list.
5. Optionally, type a short description of the profile in the Description field.

6

Click OK.

Deleting Range Profiles
Access the Ranges workspace.
To delete range profiles:

1. Select the range profile that you want to delete.
2. Select Edit, Delete Range Profile.
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Working with Outliers

This chapter provides an overview and discusses how to work with outliers.

Understanding Outliers

This section discusses:
Outliers.

Outlier configuration.
Outlier review.

Outlier repair.

Outliers

Outliers are values in a sales history that are much larger or much smaller than normally expected. Outliers can
be caused by issues such as a one-time large sales order, the actions of competitors, or natural or economic
disasters like a large-scale blackout or a stock market crash.

Due to their unpredictability, outliers can negatively affect a forecast. Because the sales history for a forecast is
often used to approximate demand, removing outliers from sales history helps to ensure that your forecasts
are more accurate by providing greater certainty in demand, reduced levels of inventory, and better customer
service.

In the Forecast Studio, working with outliers involves:

* Setting parameters for outliers.
* Detecting the outliers.
» Reviewing the outliers.

* Repairing the outliers.

Outliers appear in the Graph view, and are indicated by chevrons. This image shows outliers as they appear in
the Graph view.
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Outliers in the Graph view

The gray band behind the forecast history is a visualization of the confidence level. The confidence level is a
threshold that determines which of the unusually high or low points in the sales history are outliers.

Note. You can right-click within the Graph view to show and hide the outliers and the confidence level band.

See Also

Configuring Outliers for Detection

Outlier Configuration

The Forecast Studio is configured to automatically detect outliers. However, the default outlier detection
parameters might not be suitable for your purposes. You can change these parameters.

Before you change the outlier detection parameters, you must consider other statistical properties in the sales
history. For example, if you have seasonal demand that peaks in the summer but tapers off in the winter, this
demand can affect your sales history. However, you cannot base the detection of outliers on this demand
because, due to its seasonality, its effect is exaggerated.

The key to configuring outlier detection is to set a confidence level. If points in the sales history are within
the confidence level, then they are normal values; anything outside of the confidence level is an outlier.
For example, if you set a confidence level of 95%, any values that are outside of the 95% threshold are
considered outliers. As you lower the confidence level for a scenario, the Forecast Studio detects and
displays more outliers.

Outlier Review

Outliers appear randomly throughout a demand model. They are specific both to demand points and to periods
within a demand point. As discussed in the section Working with Outliers, outliers are marked in the Graph
view with a chevron. However, you can access a more detailed and convenient view of the outliers that

exist in a demand model by using the Scenario view.

The Scenario view contains a column labeled Outliers. This column lists the number of outliers that exist at
particular demand points. The image below shows the Scenario view with the Outliers column displayed:
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Product Lozation Charinel Outliers I
4 / / 4
Mervice Parte/Powertrain/Crank, /Canada ancouver/Outdoor Life 3 AMaze Market 3
fSevice Partz/Powertrain/Chain Stay /Canada’fancouver/Bike Sport 3 fndependent 3
Memvice Parte/Frames/Seat Post /CanadaMfancouver/Bike Sport 3 Andependent 3
/Recreational/nline Skatez/Powerline, Red  Alnited States/San Diego/Shopmart 2 A azz Market 3
fService Parte/Powertrain/Chain Rings /Canadastontreal/Outdoor Life 1 AMasz Market 2
fSemvice Partz/Mizc/Seat dGemanytunich/ietro Bike 2 fndependent 2
fService Parte/Mizc/Pedal, clip Aaermany/FrankfurtMetro Bike 1 dndependent 2
MService Parts/Mizc AUnited States/Denver ! 2
/Recreational/Bicycles/Tounng Bike, Red AUnited States/Denver/Bikemart 4 AMasz Market 2
fSemvice Parte/Powertrain/Chain Rings /Canada’fancouver/Bike Sport 3 fndependent 1
fService Parte/Mizc/Seat AGemanytunichy/B adzport 1 dndependent 1
fSemvice Partz/Framesz/Frame, Red fGermanyFrankfurt/Radsport 2 fndependent 1
MService Partz/Frames/Frame, Red /CanadaMontreal/Dutdoor Life 1 /Maze Market 1
fSemvice Partz/Framesz/Frame, Green fGermanyFrankfurt/Radsport 2 fndependent 1
fService Parts/Frames/Frame, Green Aaermany/FrankfurtMetro Bike 1 dndependent 1

Scenario view showing the Outlier column

By using the Outliers column of the Scenario view, you can quickly identify concentrations of outliers and
decide how to resolve them.

Outlier Repair

After you have identified the outliers in a scenario, you can determine whether the outliers can be explained by
known causes. If the cause of the outliers is known (for example, due to a sales promotion or the actions of a
competitor), you can model the cause in the forecast by using an event, intervention, or a predictor. Or, you can
manually adjust the outlier if the known cause is unlikely to recur in the future. Otherwise, you must decide
whether the exceptional history should be changed.

By repairing an outlier, you are mitigating its effect on a forecast. Repairing outliers involves specifying
whether you want to apply the fixes to the entire scenario, or to only the demand points that are currently
selected in the Forecast Studio. In addition, you can specify the number of standard deviations to which the
outliers are moved. Doing so controls the amount by which the effects of the outliers are mitigated.

See Also
Working with Predictors
Working with Events

Working with Interventions

Working with Outliers

This section discusses how to:

 Configure outliers for detection.

» Review outliers.

Copyright © 2006, Oracle. All rights reserved. 91



Working with Outliers

92

* Repair outliers.

Window Used to Work With Outliers

Form Name

Navigation

Usage

Forecast Studio

Shortcuts Bar, Scenarios

Displays the Scenarios
workspace.

Configuring Outliers for Detection

Access the Outliers tab on the Scenario Properties window.

To configure outliers for detection:

1. Select the Check for Outliers checkbox.

2. Complete these fields:

e Number of standard deviations

Chapter 9

The amount by which forecasts deviate from the actual demand. The value in this field must be greater

than zero.

» Confidence Level.

This is the threshold that determines which unusually high or low points in the sales history are outliers.
The confidence level is expressed as a percentage. Specifying a lower percentage causes more outliers to

be displayed. The value in this field can be between zero and one hundred.

Note. The value that appears in one field is dependent on the value that you enter in the other field. For
example, if you type 65 in the Confidence Level field, the value in the Number of standard deviations
field changes accordingly.

3. Click OK.

Reviewing Outliers

Access the Scenario view.

To review outliers, click the header of the Outliers column to sort the demand points in ascending or

descending order.

When you click the header of the Outliers column, the system groups the demand points that contain outliers.

Repairing Outliers
Access the Repair Outliers dialog box.

To repair outliers:

1. Select one of these options:

* Repair Outliers for the current Scenario.

* Repair Outliers for the selected Demand Points only.

2. Complete the Number of standard deviations that Outliers are moved to field:
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The value that you enter determines the number standard deviations from the historical fit that the outlier
will be moved. If you type zero in this field, the outliers will be aligned with the historical fit.

3. If you do not want a new forecast to be generated after the outliers are repaired, clear the Reforecast
after Outlier repair check box:

Note. If you do not clear the Reforecast after Outlier repair check box, more outliers might appear in the
Graph view. This occurs because the outlier repair operation is not recursive until all outliers are removed
from a forecast.

4. Click OK.

Note. When you repair outliers, the Note field in the Table view for the demand point that contained
the outlier displays Outlier adjusted by system.
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Working with Predictors

This chapter provides an overview of predictors, and explains how to:
* Create predictors.
* Manage predictors.

» Use predictors with scenarios.

Understanding Predictors

This section discusses:

* Predictors.
* Predictor creation.
* Demand point predictor assignment.

* How to use predictors with scenarios.

Predictors

You can generate statistical forecasts by projecting future demand based on established relationships. You do
this by modeling the relationship between historical demand and one or more predictors. Predictors are time
series that represent external, independent variables, such as the effect of a bad winter on orange crops, or
the effect of interest rates on housing starts. The information in the predictors can come from a variety of
sources, including government agencies, banks, research firms, and so on.

You can use any time series with the following characteristics as a predictor:

* It must run the entire length of your forecasting horizon.

* It cannot have any missing values.

Predictors are used only with ARIMA statistical models when generating forecasts. All other statistical
models ignore predictors. ARIMA models can use predictors to generate forecasts and can help explain the
cause-and-effect relationships that exist between demand and external variables.

When you change the forecast horizon, the system deletes the predictor series; however, the actual predictors
still exist. When the horizon is rolled forward, the predictor series is not deleted, but is rolled forward as well.
The roll forward action results in missing values at the end of the predictor series. The existence of the missing
values invalidates the predictor series. When you generate a forecast for a demand point that uses the predictor
series, the Forecast Studio indicates that the predictor series has missing values.
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You work with predictors in the Predictors workspace. You can only access the Predictors workspace if you
have an Advanced Forecast Modeling license. Contact your system administrator for more information
about this license.

The Predictors workspace is divided into three areas:

Area Description

Predictors Pane A list of all of the predictors that are available in the active
demand model.

Graph View A line graph that represents the predictor series.

Table View An editable table in which you can add, delete, or modify

predictor values for dates in the time series.

Note. To import predictor data into the Forecast Studio, you must ensure that the source data is in a format that
is compatible with the Forecast Studio.

Predictor Creation

Predictors must have data in every bucket in the history and in the forecasting horizon. This data cannot have
missing values. The forecasting engine ignores any predictors that are missing data.

Note. You should limit the number of predictors that you have associated with a forecast. A large quantity of
predictors slows down the forecasting engine and does not increase the accuracy of your forecasts.

See Also
Assigning Demand Points to Predictors
Importing Predictors

Exporting Predictors

Demand Point Predictor Assignment

After you have created a predictor, you can assign one or more demand points to it. If you are using an ARIMA
forecasting model to generate a forecast, the forecasting engine will try to use any assigned predictors. If the
forecasting engine finds a useful correlation, it applies the data in the predictors to the generated forecast.
Otherwise, the predictors are ignored.

Predictors can be assigned to demand points within a demand model and within a specific aggregation
hierarchy. You can import and export predictors that are assigned to demand points, which enables you
to exchange predictor data with other users, or to backup your predictor assignment data. The predictor
assignment data is imported from and exported to an XML file.

When you import predictors, any predictors that are assigned to specific demand points will be assigned to the
corresponding scenario points in the demand model. If a predictor for a particular demand point does not
exist, the import process fails.

Note. The system appends to the demand model any new demand points that are in the XML file that you are
importing.
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Use Predictors with Scenarios

Working with Predictors

There will be times when you have a demand point in a scenario that has several predictors associated with it.
However, when generating forecasts you might want to use only a few of the available predictors. You can
set scenario properties to indicate that one or more demand points should be considered when the forecast

is generated. By default, all predictors are used.

See Also

Assigning Demand Points to Predictors

Working with Predictors
This section discusses how to:

* Create predictors.

» Assign demand points to predictors.

* Import predictors.

» Export predictors.

* Import demand point predictor assignments.

» Export demand point predictor assignments.

Windows Used to Work with Predictors

Form Name Navigation

Usage

Forecast Studio Shortcuts Bar, Predictors

Displays the Predictors
workspace.

Forecast Studio Edit, Import Predictors

Displays the Import
Predictors dialog box,
which enables you to import
predictor information from
an XML file.

Forecast Studio Edit, Export Predictors

Displays the Export
Predictors dialog box,
which enables you to export
predictor information to an
XML file.

Creating Predictors
Access the Predictors workspace.

To create predictors:

1. Right-click anywhere in the Predictors workspace and select New Predictor from the shortcut menu.

A new predictor, with the name New Predictor.
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Note. You should rename the predictor to make the name more meaningful or descriptive.

2. In the workspace, enter data for all of the buckets in the time series by clicking each field in the table, and
then entering the value of the predictor.

Press Enter or click another field to save the changes.

4. Repeat steps 2 and 3 for each value that you want to add.

Note. You must enter values for every bucket in the history and in the forecasting horizon. The predictor
must contain no missing values.

See Also

Renaming Predictors

Assigning Demand Points to Predictors
Access the Predictors workspace, and then select the predictor to which you want to add a demand point.
To assign demand points to predictors by hierarchy:
1. Select Assign Predictor Demand Points from the Edit menu.
2. Complete these fields:

» Aggregation Level

* Product

* Location

* Channel
3. Click one of these options:

* This Demand Point Only

This option enables the user to access the demand point specified by the combination of product,
location, and channel.

* Include Siblings

This option enables you to access the specified demand point and any demand points that are on the same
aggregation level. This option is disabled if you have chosen the top/top/top aggregation level.

* Include Children

This option enables you to access the specified demand point and any demand points that are under it.
You use the Level(s) drop-down list to specify the number of levels below the current demand point.

4. Click Filter.

5. To add specific demand points to the set, select the demand points and then click Add.
6. To add all of the demand points to the set, click Add all.

7. Click OK.

To assign demand points to predictors by property:

1. Select the predictor to which you want to add a demand point, and then select Assign Predictor Demand
Points from the Edit menu.
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2. Click Demand Points by Property.
Click Add Rule.
4. Select the appropriate items from these drop-down lists:
* Property Value
Select Aggregation Level. You base your query on the aggregation level.
* Function. Select one of these values from the dropdown list:
is equal to
Only demand points containing the exact criteria in the Property Value field will be included in the list.
not equal to

All demand points, other than the ones containing the exact criteria in the Property Value field, will
be included in the list.

Contains
Demand points will be included in the list if they contain the criteria in the Property Value field.
does not contain

All demand points except those containing the criteria in the Property Value field will be included
in the list.

5. Complete the Property Value field either by typing the filtering criteria in the field or by clicking the button
immediately to the right of the field and choosing a value from the dialog box that appears.

Note. Click the plus button beside the Property Value field to add an additional property value to a rule.
Adding more property values enables you to specify multiple values for a particular property name,
and filter over one value or the other.

Repeat steps 3 to 5 for each rule that you want to add.

Click Filter to generate a list of demand points.

Select the demand points that you want to associate with the predictor, and then click Add.
Click OK.

©° > =2

Importing Predictors

Access the Predictors workspace and the Import Predictors dialog box.
To import predictors:

1. Navigate to the directory in which the XML file with the predictor data that you want to import is located.
2. Select the file, and then click Open.

See Also

Creating Predictors

Exporting Predictors

Access the Predictors workspace and the Export Predictors dialog box.
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To export predictors:

1. Navigate to the directory in which you want to save the XML file that contain the predictor data.
2. Enter a name for the XML file in the File name field, and then click Save.

Importing Demand Point Predictor Assignments
Access the Predictors workspace.
To import demand point predictor assignments:

1. Select Import Demand Point Predictor Assignment from the Edit menu.

2. Navigate to the directory in which the XML file with the predictor assignment data that you want to
import is located.

3. Select the file, and then click Open.

Exporting Demand Point Predictor Assignments
Access the Predictors workspace.
To export demand point predictor assignments:

1. Select Export Demand Point Predictor Assignment from the Edit menu.

2. Navigate to the directory in which you want to save the XML file that will contain the predictor assignment
data.

3. Enter a name for the XML file in the File name field and click Save.

Managing Predictors

100

This section explains how to:

* Rename predictors.
* Edit predictors.
* Delete predictors.

* Remove demand points from predictors.

Renaming Predictors
Access the Predictors workspace.
To rename predictors:

1. Select the predictor that you want to rename.
2. Select Rename Predictor from the Edit menu.

3. Enter a new name for the predictor and press Enter.
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Note. If you include blank spaces at the beginning or the end of the predictor name, an error message
appears, and the Forecast Studio does not change the name of the predictor:

Editing Predictors
Access the Predictors workspace.
To edit predictors:

1. Click the name of the predictor that you want to edit.

2. Locate the date in the time series table that you want to edit, and then:
« If the field in Time Series table is empty, click the field and type a value.
« If the field contains a value, click the field and type a new value to replace the old one.
Click Enter or click in another field to save the changes.

4. Repeat steps 2 and 3 for each value that you want to edit.

Deleting Predictors
Access the Predictors workspace.
To delete predictors:

Select the predictor that you want to delete.
Select Delete Predictor from the Edit menu.

When prompted, click Yes.

bl e

Repeat steps 2 and 3 for each predictor that you want to delete.

Removing Demand Points from Predictors
Access the Predictors workspace.

To remove demand points from predictors:

Select the predictor from which you want to remove a demand point.
Select Assign Predictor Demand Points from the Edit menu.

Select the demand point that you want to remove.

Click Remove.
Click OK.

A e

Using Predictors with Scenarios

Access the Scenarios workspace.
To use predictors with scenarios:

1. Select a scenario from the list in the Scenario workspace.
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Select a demand point in the Scenario view.

Select Scenario Properties from the Tools menu.

Click Predictors.

Select the predictors that you want to include with the demand point by clicking the appropriate check box.

A T

Click OK to save the changes.
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Working with Events

This chapter discusses how to:

» Work with events.
* Manage events.
* Import and export events.

* Work with events and scenarios.

Understanding Events and Interventions

This section discusses:

* Events and interventions.

* Demand point event assignment.

* Creation of interventions.

» Import and export of demand point intervention assignments.

» Use of interventions with scenarios.

Events and Interventions

In the historical time series that you are using, sudden occurrences or disturbances can negatively affect the
accuracy of the forecast. This is because the time series model that the Forecast Studio uses is intended to
chart gradual changes in demand. Any sudden changes can reduce the quality of the fit of the model, and
therefore the quality of your forecast.

However, you can improve the quality of your forecasts by modeling the occurrences or disturbances either
as events or as interventions:
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Events Interventions
An occurrence that takes place at a regular interval - for A one-time disturbances that cause a shift in demand.
example back-to-school sales, promotions or giveaways, There are two types of interventions:
and the like.
* Pulse, which cause a sudden, temporary shift in the level
You generally do not model seasonal occurrences as events. of sales or demand. Examples of pulse interventions
However, the way that you model seasonal occurrences include a blackout or damage caused by a severe storm.

depends on the time bucket you use. For example, if you
are using a monthly bucket, then Boxing Day does not have
to be modeled as an event. The forecasting engine treats
Boxing Day as seasonal. If, on the other hand, you are
using weekly buckets, you will have to model Boxing Day
as an event because it does not fall on the same week each
year.

» Step, which cause a sudden, permanent shift in the level
of sales or demand. Examples of step interventions
include a competitor opening a store near one of your
locations.

You can use events and interventions to improve the quality of a forecast by determining the effect of the event
or intervention on a forecast.

You create and manage events and interventions in the Events/Interventions workspace in the Forecast Studio.
You can only access the Events/Interventions workspace if you have an Advanced Forecast Modeling license.
Contact your system administrator for more information about this license.

The Events/Interventions workspace is divided into two areas:

Area Description

Events/Interventions Pane This area contains a list of the events and interventions that
are available in the active demand model. The events and
interventions are arranged in expandable lists.

Graph View This view is a Gantt chart that represents that events and
interventions in the demand model.

Events apply to an entire time bucket, regardless of whether the events last for the duration of that bucket.
For example, if you are working with weekly buckets and an event lasts two days, the event is valid for
the entire week.

Demand Point Event Assignment

After you have created an event, you can assign demand points to it. By doing this, you ensure that the event
is available to those demand points. Events that have demand points assigned to them can be grouped into
three categories:

* Available for inclusion in a forecast.
* Chosen for use by the forecasting engine.
» Used by the forecasting engine.
You can use these methods to assign demand points to events:
* Assign demand points by hierarchy
You select the demand points by using one of the available hierarchies.

* Assign demand points by property
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You select the demand points by specifying properties for the demand points, such as product description,
geographical location, name of a distribution channel, and so on.

See Also

Rule Based Demand Point Sets, Design Studio Implementation Guide

Creation of Interventions

Interventions are a class of events that occur only once in the past, but can have an effect on your forecasts.
There are two types of interventions:

» Pulse interventions

Pulse interventions are unexpected events such as natural disasters or the results of a wide-scale civil
disturbance that have a one-time effect on a forecast. Pulse interventions have a start date and an end date.

* Step interventions

Step interventions are events that cause a sudden, permanent change in demand. Step interventions affect a
time series into the indefinite future and have no end date.

When the Forecast Studio encounters an intervention, it ignores the sales data from the date or dates to
which the intervention applies.

Import and Export of Demand Point Intervention Assignments

You can assign interventions to demand points within a demand model and within a specific aggregation
hierarchy. You can import and export interventions that are assigned to demand points, which enables you
to back up your predictor assignment data as well as exchange intervention data with other users. The
intervention assignment data is imported from and exported to an XML file.

When you import intervention assignment data, the system assigns any interventions that are assigned to
specific demand points to the corresponding scenario points in the demand model. If an intervention for a
particular demand point does not exist, the import process fails.

Note. The system appends to the demand model any new demand points that are in the XML file that you are
importing.

Use of Interventions with Scenarios

There will be times when you have a demand point in a scenario with several interventions associated with it.
However, when generating forecasts you might want to use only a few of the available interventions. On the

Interventions tab of the Scenario Properties dialog box, you can set scenario properties to indicate that one or
more demand points should be considered when the forecast is generated.

The selections available on the Interventions tab are the interventions that have been assigned to demand points
in the scenario. By default, all interventions are used.

See Also

Assigning Demand Points to Interventions by Hierarchy
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Working with Events
This section discusses how to:

* Create events.
+ Assign demand points to events by hierarchy.

+ Assign demand points to events by property.

Windows Used to Work with Events

Form Name Navigation Usage
Forecast Studio Shortcuts Bar, Displays the
Events/Interventions Events/Interventions
workspace.
Forecast Studio Shortcuts Bar, Scenarios, Displays the Scenario View.
View, Scenario View

Creating Events
Access the Events/Interventions workspace.

When creating events, the start and end dates cannot overlap the start and end dates of other event instances.
For example, if another event instance ends on June 14, 2001, neither the start nor the end date for the new
event instance can be set to June 14, 2001.

To create events:

1. Select New Event from the Edit menu.
2. Select the new event, and then select Set Event Date from the Edit menu.

Complete these fields:

 Start Date

* End Date
4. Click Add.

Repeat steps 1 to 4 for each date combination that you want to add.
6. Click OK.

Assigning Demand Points to Events by Hierarchy
Access the Events/Interventions workspace.
To assign demand points to events by hierarchy

1. Select the event to which you want to add a demand point.
2. Select Assign Event Demand Points from the Edit menu.
Complete these fields:
» Aggregation Level
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* Product
* Location
* Channel
4. Click one of these options:
* This Demand Point Only

This option enables the user to access the demand point specified by the combination of product,
location, and channel.

* Include Siblings

This option enables you to access the specified demand point and any demand points that are on the same
aggregation level. This option is disabled if you have chosen the top/top/top aggregation level.

* Include Children

This option enables you to access the specified demand point and any demand points that are under it.
You use the Level(s) drop-down list to specify the number of levels below the current demand point.

Click Filter.

To add specific demand points to the set, select the demand points and then click Add.
To add all of the demand points to the set, click Add all.

Click OK.

S ESANG

Assigning Demand Points to Events by Property
Access the Events/Interventions workspace.
To assign demand points to events by property:

Select the event to which you want to add a demand point.
Select Assign Event Demand Points from the Edit menu.
Click Demand Points by Property.

Click Add Rule to create a new rule.

A

Select the appropriate items from the drop-down lists:
* Name

Select Aggregation Level. You use the aggregation level to base your query on.
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* Function. You can select from these options in the drop-down list:
is equal to
Only demand points containing the exact criteria in the Property Value field will be included in the list.
not equal to

All demand points, other than the ones containing the exact criteria in the Property Value field, will
be included in the list.

Contains
Demand points will be included in the list if they contain the criteria in the Property Value field.
does not contain

All demand points except those containing the criteria in the Property Value field will be included
in the list.

6. Complete the Property Value field either by typing the filtering criteria in the field, or clicking the button
that is beside the field and choosing a value from the dialog box that appears.

Note. Click the plus button beside the Property Value field to add an additional property value to a rule.
Adding more property values enables you to specify multiple values for a particular property name, and
filter on one value or the other.

7. Repeat steps 4 to 6 for each rule that you want to add.
8. Click Filter to generate a list of demand points.
9. Select the demand points that you want to associate with the event, and then click Add.

10. Click OK to save the changes.

Managing Events

This section explains how to:

* Rename events.

« Edit event dates.

* Delete event dates.
* Delete events.

* Remove demand points from events.

Renaming Events
Access the Events/Interventions workspace.
To rename events:

1. Select the event that you want to rename.
2. Select Rename Event from the Edit menu.

3. Enter a new name for the event and press Enter.
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Adding New Event Dates
Access the Events/Interventions workspace.
To add new event dates

1. Select the event that you want to edit.
2. Select Set Event Dates from the Edit menu.
3. Complete these fields:

+ Start Date

* End Date
4. Click Add.
5. Repeat steps 3 and 4 for each date combination that you want to add.
6. Click OK.

Changing Event Dates

Access the Events/Interventions workspace.

To change event dates:

1. Select the event that you want to edit.

2. Select Set Event Dates from the shortcut menu.

3. Click a date and then edit these fields as necessary:
+ Start Date
* End Date

Note. The start and end dates cannot overlap with the start and end dates of other events. For example, if
another event ends on June 14, 2001, the start and end dates for this event cannot be set to June 14, 2001.

4. Click OK.

Changing the Dates of a Single Event
Access the Events/Interventions workspace and open the Graph view.
To change the dates of a single event:

1. Double-click the event that you want to edit.

2. Click a date and then edit these fields as necessary:
+ Start Date
* End Date

3. Click OK to save the changes.

Deleting Event Dates

Access the Events/Interventions workspace.
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To delete event dates:

Select the event that you want to edit.

Select Set Event Dates from the Edit menu.

el S

Click OK.

Deleting Events

Access the Events/Interventions workspace.
To delete events:

1. Select the event that you want to delete.
2. Select Delete Event from the Edit menu.
3. Click Yes.

Removing Demand Points from Events
Access the Events/Interventions workspace.

To remove demand points from events:

Select Assign Event Demand Points from the Edit menu.
Click the demand points that you want to remove.

Click Remove.

Click OK.

nok wh o
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Click the event dates pair that you want to delete, and then click Delete.

Select the event from which you want to remove a demand point.

Importing and Exporting Events

110

This section explains how to:

* Import and export events.

* Import and export demand point event assignments.

Importing Events
Access the Events/Interventions workspace.
To import events:

1. Select Import Events from the Edit menu.

2. Navigate to the directory in which the XML file with the event data that you want to import is located.

3. Select the file, and then click Open.
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Exporting Events
Access the Events/Interventions workspace.
To export events:

1. Select Export Events from the Edit menu.
2. Navigate to the directory in which you want to save the XML file that will contain the event data.
3. Enter a name for the XML file in the File name field and click Save.

Importing Demand Point Event Assignments

Access the Events/Interventions workspace.
To import demand point event assignments:

1. Select Import Demand Point Event Assignment from the Edit menu.

2. Navigate to the directory in which the XML file that contains the event assignment data that you want to
import is located.

3. Click the name of the file, and then click Open.

Exporting Demand Point Event Assignments
Access the Events/Interventions workspace.
To export demand point event assignments:

1. Select Export Demand Point Event Assignment from the Edit menu.

2. Navigate to the directory in which you want to save the XML file that will contain the event assignment
data.

3. Enter a name for the XML file in the File name field and click Save.

Working with Events and Scenarios

There will be times when you have a demand point in a scenario with several events associated with it.
However, when generating forecasts you might want to use only a few of the available events. On the Events
tab of the Scenario Properties dialog box, you can set scenario properties to indicate that one or more demand
points should be considered when the forecast is generated.

The selections available on the Events tab are the events that have been assigned to demand points in the
scenario. By default, all events are used.

See Also
Assigning Demand Points to Events by Hierarchy

Assigning Demand Points to Events by Property
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Using Events with Scenarios
Access the Events/Interventions workspace.
To use events with scenarios:

Select a scenario from the list.

Select a demand point in the Scenario view
Select Scenario Properties from the Tools menu.
Click Events.

Ll e

Note. The Events tab is disabled if you select multiple demand points in the Scenario view.

5. Select the events that you want to include by clicking the appropriate check boxes.
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Working with Interventions

This chapter discusses how to:

* Work with interventions.
* Manage interventions.

e Use interventions with scenarios.

Working with Interventions

This section discusses how to:

» Create interventions.

» Assign demand points to interventions by hierarchy.

» Assign demand points to interventions by property.

Windows Used to Work with Interventions

Form Name Navigation Usage
Forecast Studio Shortcuts Bar, Displays the
Events/Interventions Events/Interventions
workspace.

Forecast Studio

View, Scenario View

Displays the Scenario View.

Creating Interventions

Access the Events/Interventions workspace.

To create interventions:

1. Select New Intervention from the Edit menu.

2. Select the new intervention, and then select Set Intervention Dates from the shortcut menu.

Note. For new interventions, the system assigns a default start date based on the beginning date of the

horizon.

3. Click one of these options:

e Pulse
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» Step

4. Complete these fields:
+ Start Date.
* End Date

Note. If you are creating a step intervention, you cannot enter an end date.

5. Click OK to save the new intervention.

Note. In the Graph view, a pulse intervention is denoted by a red inverted triangle icon. A step intervention
is denoted by a yellow diamond icon.

Assigning Demand Points to Interventions by Hierarchy
Access the Events/Interventions workspace.
To assign demand points to interventions by hierarchy:

1. Select the intervention to which you want to add a demand point.
2. Select Assign Intervention Demand Points from the Edit menu.
3. In the Assign Demand Points window, Complete these fields:

» Aggregation Level

* Product

* Location

* Channel
4. Click one of these options:

* This Demand Point Only

* Include Siblings

* Include Children
5. Click Filter.

A list of the demand points for the criteria that you defined in the previous steps appears in the Filtered
Demand Points portion.

6. Click one of these options:
» Add Selected.
* Add all.

7. Click OK.

Assigning Demand Points to Interventions by Property
Access the Events/Interventions workspace.
To assign demand points to interventions by properties:

1. Right-click the intervention to which you want to add a demand point.
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Select Assign Intervention Demand Points from the Edit menu.
Click Demand Points by Property.
Click Add Rule.

Select the appropriate items from the drop-down lists:

A

* Name
Select Aggregation Level. You use the aggregation level to base your query on.
* Function. You can select from these options in the drop-down list:
is equal to
Only demand points containing the exact criteria in the Property Value field will be included in the list.
not equal to

All demand points, other than the ones containing the exact criteria in the Property Value field, will
be included in the list.

Contains
Demand points will be included in the list if they contain the criteria in the Property Value field.
does not contain

All demand points except those containing the criteria in the Property Value field will be included
in the list.

6. Complete the Property Value field either by typing the filtering criteria in the field, or clicking the button
that is beside the field and choosing a value from the dialog box that appears

Note. Click the plus button beside the Property Value field to add another property value to a rule. Adding
more property values enables you to specify multiple values for a particular property name, and filter on
one value or the other.

7. Repeat steps 4 to 6 for each rule that you want to add.

8. Click Filter to generate a list of demand points.

9. Select the demand points that you want to associate with the event, and then click Add.
10. Click OK.

Managing Interventions

This section discusses how to:

 Edit interventions.

* Rename interventions.

* Delete interventions.

* Remove demand points from interventions.
» Import interventions.

* Export interventions.
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* Import demand point intervention assignments.

» Export demand point intervention assignments.

Editing Interventions
Access the Events/Interventions workspace.
To edit interventions:

1. Do one of the following:

Chapter 12

* In the Events/Interventions workspace, select the intervention that you want to edit, and then select Set

Intervention Dates from the Edit menu.

* In the Graph view, double-click the icon representing the intervention.
2. Click one of these options to change the type of intervention:

* Pulse

» Step
3. Complete these fields:

* Start Date.

* End Date.

Note. If you clicked the Step option, you cannot edit the End Date field.

4. Click OK.

Renaming Interventions
Access the Events/Interventions workspace.
To rename interventions:

1. Select the intervention that you want to rename.
2. Select Rename Intervention from the Edit menu.

3. Enter a new name for the intervention and press Enter.

Deleting Interventions
Access the Events/Interventions workspace.
To delete interventions:

Select the intervention that you want to delete.
Select Delete Intervention from the Edit menu.
Click Yes.

Repeat steps 1 to 3 for each intervention that you want to delete.

Ll e
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Removing Demand Points from Interventions
Access the Events/Interventions workspace.

To remove demand points from interventions:

Select the intervention from which you want to remove a demand point.
Select Assign Intervention Demand Points from the Edit menu.

Click the demand point that you want to remove.

Click Remove.
Click OK.

A e

Importing Interventions
Access the Events/Interventions workspace.
To import interventions:

1. Select Import Interventions from the Edit menu.
2. Navigate to the directory in which the XML file with the intervention data that you want to import is located.
3. Click the name of the file, and then click Open.

Exporting Interventions
Access the Events/Interventions workspace.
To export interventions:

1. Select Export Interventions from the Edit menu.
2. Navigate to the directory in which you want to save the XML file that will contain the intervention data.

3. Enter a name for the XML file in the File name field and click Save.

Importing Demand Point Intervention Assignments
Access the Events/Interventions workspace.
To import demand point intervention assignments:

1. Select Import Demand Point Intervention Assignment from the Edit menu.

2. Navigate to the directory in which the XML file that contains the intervention assignment data that
you want to import is located.

3. Click the name of the file, and then click Open.

Exporting Demand Point Intervention Assignments
Access the Events/Interventions workspace.
To export demand point intervention assignments:

1. Select Export Demand Point Intervention Assignment from the Edit menu.
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2. Navigate to the directory in which you want to save the XML file that will contain the intervention
assignment data.

3. Enter a name for the XML file in the File name field and click Save.

Using Interventions with Scenarios

Access the Events/Interventions workspace.
To use interventions with scenarios:

Select a scenario from the list in the Scenario workspace.
Select a demand point in the Scenario view.

Select Scenario Properties from the Tools menu.

el

Click Interventions.

Note. The Interventions tab is disabled if you select multiple demand points in the Scenario view.

5. Select the interventions that you want to include by clicking a check box.

6. Click OK to save the changes.
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Working with Forecast Accuracy Reports

This chapter discusses how to work with forecast accuracy reports.

Understanding Forecast Accuracy Reports

This section provides an overview of forecast accuracy reports, and discusses:

» Forecast accuracy reports.

» Forecast accuracy report definition.

Forecast Accuracy Reports

Defining a forecast accuracy report allows you to compare the percentage of deviation between your forecast
and actual demand. You can also use the report to compare the results generated with the various goodness of
fit statistics. The report enables you to isolate where strengths and weaknesses in the forecasting process of
your enterprise exist, and the demand points or products on which you need to focus more attention.

You should run a report when you have a clear idea of what your actual sales are, which can be over the space
of several months or even over several forecasting periods. You can also run the report at regular intervals
during a forecasting horizon. You might discover, for example, that forecasts generated at the beginning of a
forecasting horizon are less accurate than those generated towards the middle in the horizon. With a forecast
accuracy report, you can isolate the best time to forecast. Then you can use this knowledge to improve your
forecasting processes.

You can save the report in one of two formats:

* A Comma Separated Values (CSV) file.

The CSV file is a flat file containing information in tabular format. You can import the CSV file into any
spreadsheet or database application, like Microsoft Excel.

* An XML file.

Using the Extensible Stylesheet Transformation Language (XSLT), you can transform the XML file to such
formats as HTML (for viewing in a Web browser) or Adobe PDF (for printing).

The report displays this information about the forecast:

* Demand point data, which consists of product, location, and channel information
You can specify the demand points to include in the report.
* The goodness of fit statistics for the forecast

» Compares sales history to forecast history information
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Note. If specific units of measure have been assigned to demand points, the demand points that do not
use those units of measure do not appear in the accuracy report. Instead, those demand points are listed
as "undefined" in the report.

This sample shows a forecast accuracy report in CSV format that has been imported into Microsoft Excel:

E3 Microsoft Excel - marketing.csy =10l x|
J@ File Edit “ew Insert Format Tools Data MWindow Demand Management Help Acrobat ;Iilﬁl
DEeEe @RY L@ - @ = 4 8 @E 2 e -0 - |B|IES|d-A- 7
ek =
Al d =| Unit Of Measure
A B | c | b | E [ F | &6 [ H [
1 |Unit Of Measure Each =
| 2 |Product Path Location Path Channel Path Product I Location || Channel IcMAD - MaiWAD - Sal MFE
| 3 |/Recreational/Bicycles/Ex /CanadaiMontreal/Bike Sy /Mass Market 42212 c2 Undefined |Undefined Unde
| 4 |/Recreational/Bicycles/Ex /Canada/Toronto/Bike Spo/Mass Market 42211 Cc2 Undefined Undefined Unds
| 5 |/Recreational/Bicycles/Ex /CanadaiMontreal/Bike Sp/Mass Market 420 12 c2 Undefined |Undefined Unde
| B |/Recreational/Bicycles/Ex /CanadaToronto/Bike Spo/Mass Market 420011 Cc2 Undefined Undefined Unds
| 7 |/Recreational/Bicycles/Md/CanadaiMontreal/Bike Sp/Independent 322 12 1 2145 183.208
| 8 |/Recreational/BicyclesMd/CanadaiMontreal/Outdao Mass Market 32215 C2 3.375 3.75
| 9 |/Recreational/Bicycles/Md/CanadaToronto/Bike Spo/independent 322 11 1 0875 1.08333
| 10 |/Recreational/BicyclesMd/CanadaTaronta/COutdaar Mass Market 32217 C2 0958333 1.29167 0.2
| 11 |/Recreational/Bicycles/Ma/Canadavancouver/Bike {/Independent 32230 1 5.058333 475 Bl
| 12 |/Recreational/BicyclesMd/Canadatancouver/Outdc Mass Market 322128 C2 54 570833
| 13 |/Recreational/Bicycles/Ma/Canada/Montreal/Bike Sp/lndependent 320 2 1 354167 358333 3!
| 14 |/Recreational/BicyclesMd/CanadaiMontreal/Bike Sy /Mass Market 320 L2 c2 Undefined |Undefined Unde
| 15 |/Recreational/Bicycles/Ma/Canada/Montreal/Outdoo /Mass Market 3200115 C2 B7.375| 55625 &
| 16 |/Recreational/Bicycles/Md/CanadaTaranto/Bike Spofindependent 32001 1 3875 320833
| 17 |/Recreational/Bicycles/Md/CanadaToronto/Cutdoor /Mass Market 32017 C2 333333 304167 3.
| 18 |/Recreational/BicyclesMd/Canadat/ancouver/Bike fndependent 320130 1 4 41667 391667 4.
| 13 |/Recreational/Bicycles/Md/Canadatancouver/Outdc Mass Market 320129 C2 720833 10.0833) 7.
| 20 |/Recreational/Bicycles/Tat/CanadaiMontreal/Bike Sp/independent 22212 1 9.125| 816667
| 21 |/Recreational/Bicycles/Tal/Canada/Montreal/Bike Sy /Mass Market 22212 Cc2 Undefined |Undefined Und
| 22 |/Recreational/Bicycles/Tat/CanadaiMontreal/Outdaoo /Mass Market 222018 CZ 279167 418667 2.
| 23 |/Recreational/Bicycles/Tat/CanadaTaranto/Bike Spo/independent 2221 1 454167 420833 4. -
¥ BNl P Ny = P | ' W Tl ale (T, 4o (T kel ihd hdowleod AT AT [ada] o T oA
4[4[ » [#['marketing |4 LUJ
Ready I I mml [ [y

A forecast accuracy report in Microsoft Excel

Once the report is in your spreadsheet application, you can use the filtering and sorting function in the
application to focus on problem areas. The filtering and sorting functions enable you to display specific
values in a row or column of the report. For example, you can use a filter to isolate a location or a specific
error in the forecast.

See Also

Assigning Units of Measure to Demand Points, EnterpriseOne Design Studio Implementation Guide

Forecast Accuracy Report Definition

When you define a forecast accuracy report, you are setting the parameters for the report. This process
involves specifying demand points to include in the report, statistical measures to use, the location to save the
report file, and so on. After defining the report, you can later edit its parameters.

You can define forecast accuracy reports in two ways:

* By demand point aggregation
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Returns a list of demand points that are based on the aggregation hierarchy of the demand model you are
working with. Once the list of demand points is generated, you must search through the list to find the
demand points you want to use in your scenario.

* By demand point properties

Returns a list of demand points that chosen using a filter. By defining a filter, you are creating a rule that
produces a list of demand point based on product, location, or channel attributes

Working with Forecast Accuracy Reports

This section discusses how to:

* Define forecast accuracy reports by demand point aggregation.

* Run forecast accuracy reports.

+ Edit forecast accuracy reports based on demand point aggregations.

« Edit forecast accuracy reports based on demand point properties.

Window Used to Work with Forecast Accuracy Reports

Form Name Navigation Usage
Forecast Studio Shortcuts Bar, Forecasts, Displays the Forecast
Tools’ Accuracy Report ACCuraCy Report dlalog box.

Defining Forecast Accuracy Reports by Demand
Point Aggregation

Access the Forecast Accuracy Report dialog box.
To define forecast accuracy reports by demand point aggregation:

1. If this is the first time you have run a Forecast Accuracy report, click Add to create a new report.
2. Enter a descriptive name for the report.
3. Select one of these options:

* csv

e xml

4. Enter a file name for the report in the Please enter the name of the file and the directory where the report
will be saved field.

By default, reports are saved to the Samples subfolder of the folder where the application is installed.
Click Next.
Select the unit of measure that you want to use with the report from the Unit of Measure drop-down list.

Select one or more forecast histories that you want to compare to the sales history.

S A

Select one or more statistical measures that you want to include in the report. Valid options are:
* MAD
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10.

I1.

12.

13.

14.

15.

* MAPE

* MFE

* MSE
Click Next.

Select the level of aggregation for the demand points that you want to include in the report from the
Aggregation Level drop-down menu.

Select each of these:

* Product.

* Location.

* Channel.

Select one of these options:
* This Demand Point Only
* Include Siblings

* Include Children

Click Filter.

Do one of the following:

* Click Add all.

* Select the demand points that you want to use and then click Add selected.

When you have added the demand points that you want to include in the report, click Finish to save
the report.

Defining Forecast Accuracy Reports by Demand Point Properties

Access the Forecast Accuracy Report dialog box.

To define forecast accuracy reports by demand point properties:

1.
2.

Click Add to create a new report.
Select one of these options:
VY

e xml

. Enter a file name for the report in the Please enter the name of the file and the directory where the report

will be saved field.

By default, reports are saved to the Samples subfolder of the folder where the application is installed.
Complete the Unit of Measure field.

Select one or more forecast histories that you want to compare to the sales history.

Select one or more of these statistical measures that you want to include in the report:

* MAD

* MAPE

* MFE
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« MSE
7. Click Next.
Click Demand Points by Property.
9. Complete the Property Name field.
10. Complete the Rule field. You can select from these options in the drop-down list:
* This Demand Point Only
* Include Siblings
¢ Include Children
11. Complete the Property Value field and then click OK.

You can type the filtering criteria in the field or click the button next to the field and select a value from
the dialog box that appears.

Note. Click the plus button beside the Property Value field to add an additional property value to a
rule. Entering additional property values enables you to specify multiple values for a particular property
name, and filter on one value or the other.

12. Click Add Rule and repeat steps 9 to 11 for each new filter that you want to define.
13. Click Filter.
14. Do one of the following:

* Click Add all.

+ Select the specific demand points that you want to use and then click Add selected.

15. Click Finish to save the report.

Running Forecast Accuracy Reports
Access the Forecast Accuracy Report dialog box.
To run forecast accuracy reports:

1. Select the report that you want to run.
2. Click Run.
3. Click Close.

Editing Forecast Accuracy Reports Based on Demand
Point Aggregations

Access the Forecast Accuracy Report dialog box.
To edit forecast accuracy reports based on demand point aggregations:

1. Select the report you want to edit and then click Edit.

2. If necessary, change the file name and location for the report by editing the value in the Please select
the filename (.csv or .xml) for this report field.

3. Click Next.
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4. Select a unit of measure from the Unit Of Measure drop-down list.
Select the forecast history that you want to compare to the sales history in the report.
6. If you want to include another or a different statistical measure in the report, select one of these options:
« MAD
* MAPE
* MFE
* MSE
7. Click Next.

8. Select the level of aggregation for the demand points you want to include in the report from the
Aggregation Level drop-down list.

9. Select each of these:
* Product.
* Location.
* Channel.

10. Select one of these options:
* This Demand Point Only
* Include Siblings
* Include Children

11. Click Filter.

12. Select the demand points you want to add to the report and then click one of these buttons:
» Add selected.
* Add all.

13. When you have added the demand points you want to include in the report, click Finish.

Editing Forecast Accuracy Reports Based on Demand
Point Properties

Access the Forecast Accuracy Report dialog box.
To edit forecast accuracy reports based on demand point properties:

1. Select the report you want to edit and then click Edit.

2. If necessary, change the file name and location for the report by editing the value in the Please select
the filename (.csv or .xml) for this report field.

Click Next.
Select a unit of measure from the Unit Of Measure drop-down list.

Select the forecast history that you want to compare to the sales history in the report.

A

If you want to include another or a different statistical measure in the report, select of these options:
* MAD
* MAPE
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* MFE
« MSE
7. Click Next.
Click Demand Points by Property.
9. Select the property you want to filter on.
10. Select from these options in the drop-down list:
* is equal to
* not equal to
* contains
* does not contain
11. In the Property Value field, do one of the following:
* Enter the filtering criteria in the field.

* Click the button that is beside the field, then select a value from the dialog box that appears, and then
click OK.

12. Click Filter.
13. Do one of the following:
* Click Add all.
* Select the demand points that you want to use and then click Add selected.

14. Click Finish to save the changes to the report.

Renaming Forecast Accuracy Reports
Access the Forecast Accuracy Report dialog box.
To rename forecast accuracy reports:

1. Select the report that you want to rename.
2. Click Rename.

3. Enter a new name for the report, and then press Enter.

Deleting Forecast Accuracy Reports
Access the Forecast Accuracy Report dialog box.
To delete forecast accuracy reports:

1. Select the report that you want to delete.
2. Click Delete.
3. When prompted, click Yes to delete the report.
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Working With Forecast History Data

This chapter provides an overview of forecast history data and discusses how to:

* Import forecast history data.
» Export forecast history data.
* Clear forecast history data.

* View forecast history data.

Understanding Forecast History Data

As the forecast horizon rolls forward, forecast data that resides outside of the forecast horizon is considered
forecast history. Forecast history data is valuable when compared with sales history data (actuals).

Comparing forecast history data to sales history data reveals:

* Forecast accuracy.
» Changes in forecasting patterns.

* Possible problems in the forecasting process.

Understanding Importing Forecast History Data

You can import forecast history data into a forecast version in a demand model from either a local directory or
a network directory. The forecast history data that you import is in XML format.

Only the default unit of measure is imported with forecast history data. In addition, when you import forecast
history data, the demand points are displayed as fixed values. If you import forecast history data that has
missing values, the fields for the missing values are blank when you view the imported data.

Note. You must have administrative permissions to import forecast history data.

Understanding Exporting Forecast History Data

You can export forecast history data for a forecast version in a demand model to a directory or network drive.
The forecast history data that you import is in .xml format. If you revise the data in the XML file and later
import this file into the same demand model, all of the demand points are fixed.

Note. Only the default unit of measure is exported with forecast history data.
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Windows Used When Working with Forecast History Data

Form Name Navigation Usage
Forecast Studio Shortcuts Bar, Forecasts Displays the Forecasts
workspace.
Forecast Studio View, Graph Displays the Graph view,

which shows a line graph
that illustrates the historical
demand and the forecast

data.

Chapter 14

Importing Forecast History Data

Access the Forecasts workspace.

To import forecast history data:

nok wh o

Click Open.

Select Import Forecast History from the Edit menu.

Click the forecast version for which you want to import forecast history

Navigate to the directory that contains the data that you want to import.

Select the file that contains the forecast history information.

Exporting Forecast History Data

Access the Forecasts workspace.

To export forecast history data:

wok wh o=

Click Save.

Select Export Forecast History from the Edit menu.

Select the forecast version for which you want to export forecast history.

Navigate to the directory in which you want to save the forecast history.

In the File Name field, type a name for the forecast history data.

Clearing Forecast History Data

Access the Forecasts workspace.

To clear forecast history data:

1. Select the forecast version for which you want to clear forecast history.

128
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2. Select Clear Forecast History from the Edit menu.

Viewing Forecast History Data in the Time Series Table

Access the Forecasts workspace.

To view forecast history data in the Time Series table, select the forecast version for which you want to view
data. Forecast history data appears in the Time Series table as shaded.

If the Time Series table is not visible, you must first open it by selecting Time Series from the View menu.

Viewing Forecast History in Graph View

Access the Forecasts workspace and the Graph view.
To view forecast history data in Graph view, select the forecast version for which you want to view data.

Forecast history data appears to the left of the forecast horizon in the graph.
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CHAPTER 15

Working With Effective Dates

This chapter provides an overview of effective dates and discusses how to:

* View demand points with effective dates.

» Edit demand points with effective dates.

Understanding Effective Dates

Effective dates indicate when demand points are available or unavailable in the forecasting process. Effective
dates are set and changed in the demand model using the Design Studio application. You can set the effective
start date and effective end date for a single demand point or for multiple demand points.

You can view demand points with effective dates in the Time Series table. If you are in the Forecasts
workspace, all effective dates appear under the Forecast column. If you are in the Scenarios workspace, all
effective dates appear in the column of the forecast version for which you are viewing data. Demand point
values that fall outside of the start and end effective dates are highlighted.

You can also view demand points with effective dates in the Graph view. The effective start and end dates
for demand points appear in the Graph view as broken lines and have a black triangle at the base and
top of the lines.

Viewing Demand Points with Effective Dates in
the Time Series Table

This section discusses how to view demand points with effective dates in a time series table.
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Windows Used to View Demand Points with Effective
Dates in the Time Series Table

Form Name

Navigation

Usage

Forecast Studio

Shortcuts Bar, Scenarios

Displays the Scenarios
workspace.

Forecast Studio

View, Time Series

Displays the Time Series
table, which lists the

sales history and forecast
information for the scenario
on a monthly basis.

Forecast Studio

View, Graph

Displays the Graph view,
which shows a line graph
that illustrates the historical
demand and the forecast

for a scenario.

Chapter 15

Viewing Demand Points with Effective Dates in

the Time Series Table

Access the Scenarios workspace and the Time Series table.

To view demand points with effective dates in the Time Series table:

1. Select the forecast version for which you want to view data.

2. Select these options from the Navigation bar:

» Aggregation Level

* Product
* Location
* Channel

The demand points that you selected appear in the Table view with either scenario or forecast versions
displaying effective dates within the start and end effective date lines.

Viewing Demand Points with Effective Dates in Graph View

Access the Scenarios workspace and the Graph view.

To view demand points with effective dates in the Graph view:

1. Select the forecast version for which you want to view data.

2. Select these options from the Navigation bar:

» Aggregation Level

132
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e Product
* Location
* Channel

3. Select Graph from the View menu.

Editing Demand Points With Effective Dates in
the Time Series Table

Access the Scenarios workspace and the Time Series table.

You can edit demand points with effective dates in the Time Series table. You edit the information in the
Time Series table by choosing a value from the Forecast field and specifying your change. When you edit
effective dates in the Time Series table, the changes are reflected in the Graph view. After you edit demand
point values, you generate the scenario.

To edit demand points with effective dates in the Time Series table:

1. Select the forecast version for which you want to view data.
2. From the Navigation bar, select these options:

» Aggregation Level

* Product

* Location

* Channel

3. In the Time Series table, double-click the forecast field that contains the value for the effective date
that you want to edit.

4. Enter a new value in the field, and then press Enter.

Editing Demand Points With Effective Dates in the Graph View

Access the Scenarios workspace and the Graph view.

You can edit demand points with effective dates in the Graph view. You can view graphs for individual
demand points by choosing the appropriate demand point from the Scenario View pane. When you edit
effective dates in the Time Series table, the changes are reflected in the Graph view. After you edit demand
point values, you generate the scenario

To edit demand points with effective dates in Graph view:

1. Select the forecast version for which you want to view data.
2. From the Navigation bar, select these options:

» Aggregation Level

* Product
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» Location

e Channel
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